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Important Notice 
This guide is subject to the following conditions and restrictions: 

This User's Guide provides documentation for the PowerTerm® Pro Series 

of products. Your specific PowerTerm Pro product might include only a 

portion of the features documented in this Guide. 

The proprietary information belonging to Ericom® Software is supplied 

solely for the purpose of assisting explicitly and properly authorized users 

of PowerTerm Pro. 

No part of its contents may be used for any other purpose, disclosed to 

any person or firm, or reproduced by any means, electronic and 

mechanical, without the express prior written permission of Ericom® 

Software. 

The text and graphics are for the purpose of illustration and reference 

only. The specifications on which they are based are subject to change 

without notice. 

The software described in this document is furnished under a license 

agreement. The software may be used or copied only in accordance with 

the terms of that agreement. 

Information in this document is subject to change without notice. 

Corporate and individual names and data used in examples herein are 

fictitious unless otherwise noted. 

 

 

 

 

 

 

 

 

PTPROAdminMan20140709 

 

 

Copyright© 2014 Ericom® Software Ltd. 

Ericom and PowerTerm are registered trademarks of Ericom® Software. 

Other company and brand, product and service names are trademarks or 

registered trademarks of their respective holders. 



 

        Ericom® PowerTerm® Pro           3 of 150         User’s Guide 

Table of Contents 

Important Notice ...................................................................................... 2 

1. INTRODUCTION ............................................................................................ 8 

What is new in 10.2? ............................................................................... 8 

PowerTerm Pro Features ........................................................................ 8 

System Requirements............................................................................. 9 

PowerTerm Pro Setup ...................................................................................................9 

Connection Overview ................................................................................................. 10 

2. THE POWERTERM PRO INTERFACE ....................................................... 13 

Menu Bar ................................................................................................ 15 

File Menu .................................................................................................................... 15 

Edit Menu .................................................................................................................... 16 

View Menu .................................................................................................................. 18 

Terminal Menu ............................................................................................................ 18 

Communication Menu ................................................................................................. 19 

Sessions Menu ........................................................................................................... 20 

Options Menu ............................................................................................................. 20 

Tools Menu ................................................................................................................. 21 

Script Menu ................................................................................................................. 21 

Window Menu ............................................................................................................. 22 

Help Menu .................................................................................................................. 22 

Toolbar ................................................................................................... 23 

Hot Keys ................................................................................................. 25 

Connection Dialog................................................................................. 26 

Terminal Setup Dialog .......................................................................... 29 

General Property Page ............................................................................................... 30 

Display Property Page ................................................................................................ 34 

Keyboard Property Page ............................................................................................ 37 



 

        Ericom® PowerTerm® Pro           4 of 150         User’s Guide 

Sound: ........................................................................................................................ 42 

Terminal Sound Setup ................................................................................................ 42 

Printer Property Page ................................................................................................. 44 

Advanced Printing Setup ............................................................................................ 46 

Tabs Property Page .................................................................................................... 48 

Colors Property Page ................................................................................................. 50 

Preferences Property Page ........................................................................................ 53 

Security Settings Dialogs ..................................................................... 55 

SSL Security ............................................................................................................... 55 

SSH Security .............................................................................................................. 55 

3. STARTING AND STOPPING SESSIONS ................................................... 56 

Starting PowerTerm Pro Using a Setup File ....................................... 57 

Starting PowerTerm Pro Using a Script .............................................. 57 

Starting PowerTerm Pro with Auto Connect ....................................... 57 

Starting a New PowerTerm Pro Session ............................................. 58 

Ending a PowerTerm Pro Session ....................................................... 58 

4. DEFINING EMULATIONS ........................................................................... 61 

5. DEFINING CONNECTIONS ......................................................................... 64 

Show/Hide Desktop Components ........................................................ 67 

Changing the Desktop Display ............................................................ 67 

Setting Fonts ............................................................................................................... 68 

Setting Color ............................................................................................................... 69 

Setting work area ........................................................................................................ 69 

Selecting Text ........................................................................................ 72 

6. KEYBOARD SETTINGS .............................................................................. 75 

Mapping Keys ........................................................................................ 75 



 

        Ericom® PowerTerm® Pro           5 of 150         User’s Guide 

Saving and Opening Keyboard Mapping Settings ............................. 77 

Keyboard Behavior ............................................................................... 77 

7. SOFT BUTTONS AND POWER PAD.......................................................... 82 

8. PRINTING .................................................................................................... 85 

General Printing Operations ................................................................ 86 

IBM 5250 Printer Session Data Conversion ........................................ 90 

Non-IBM 5250 Printer Session Data Conversion ................................ 92 

Escape Sequences ................................................................................ 93 

Printer Configuration Files (.prt) ................................................................................. 93 

Modifying Printer Settings via the .PED file ................................................................ 94 

Troubleshooting Printing Issues ......................................................... 95 

9. SCRIPTS ...................................................................................................... 97 

10. POWERTERM PRO ENTERPRISE - VBA ................................................ 101 

PowerTerm Pro Enterprise VBA Editor ............................................. 102 

PowerTerm Pro Enterprise VBA Sample Scripts .............................. 105 

PowerTerm Pro Enterprise VBA Commands .................................... 107 

VBA Examples ..................................................................................... 114 

11. APPLICATION PROGRAM INTERFACE (API) ........................................ 117 

12. POWERTERM PRO FTP CLIENT ............................................................. 118 

Features and Benefits ......................................................................... 118 

Concepts .............................................................................................. 118 

PowerTerm Pro FTP Client Window .................................................. 120 



 

        Ericom® PowerTerm® Pro           6 of 150         User’s Guide 

Menu Bar .................................................................................................................. 120 

Toolbar ...................................................................................................................... 120 

A Quick Guide through PowerTerm Pro FTP Client ......................... 121 

Configuration Settings ........................................................................ 123 

Defining PowerTerm Pro FTP Client Preferences .................................................... 123 

Selecting a File Transfer Mode ................................................................................. 125 

File Transfer Setup Options ...................................................................................... 127 

Working with Configuration Files ...................................................... 128 

Defining Connection Parameters ....................................................... 128 

Connection Parameters ............................................................................................ 129 

Firewall Parameters .................................................................................................. 131 

Working with Connection Profiles ..................................................... 132 

Connecting to an FTP Site .................................................................. 133 

Using the FTP Log Window ................................................................ 133 

Working with Local and Remote Directories and Files .................... 134 

Transferring Files ................................................................................ 136 

Automatic File Transfer ...................................................................... 137 

File Transfer Conventions ........................................................................................ 138 

Disconnecting and Exiting ................................................................. 139 

Troubleshooting the PowerTerm Pro FTP Client ............................. 140 

13. CREATING CAPTURE AND LOG FILES TO SEND TO ERICOM 

SUPPORT................................................................................................ 141 

14. LIST OF SUPPORTED CODE PAGES ..................................................... 142 

VT and other character mode emulations ......................................... 142 

IBM (EBCDIC) emulations ................................................................... 143 



 

        Ericom® PowerTerm® Pro           7 of 150         User’s Guide 

15. MENU ITEMS FOR POWERTERM PRO ................................................... 147 

About Ericom ....................................................................................... 150 



 

        Ericom® PowerTerm® Pro           8 of 150         User’s Guide 

1. INTRODUCTION 

PowerTerm Pro is a fully functional terminal emulator for Microsoft 

Windows. Supported emulation types include IBM, UNIX, HP, VMS and 

Tandem. PowerTerm Pro enables connections to a single or to multiple 

hosts at the same time.  PowerTerm Pro has two main features to 

emulate a traditional “dumb” host terminal: 

 Terminal display emulation, PowerTerm Pro emulates the exact 

display of the chosen terminal. It presents host applications 

precisely as they would appear on the terminal. Once the PC 

connects to a host computer, all host operations can be 

performed as if the PC is an actual host terminal. 

 Terminal keyboard emulation, PowerTerm Pro enables you to 

emulate the selected terminal's keyboard by mapping the PC 

keys to match the host keys. Keyboard mapping definitions are 

stored in a .ptk file. 

PowerTerm Pro also provides various options to customize and optimize 

the working environment such as: 

 Power Pad, a programmable floating keypad. (Windows edition 

only.) 

 Soft buttons, programmable buttons located at the bottom of the 

PowerTerm Pro window. 

 PowerTermScript Language (PSL), a full-featured programming 

language, which enables you to create scripts for automating 

tasks. For example, you can create a PSL script for automatic 

login. Scripts can be used at startup of PowerTerm Pro, or can be 

utilized any time during a PowerTerm Pro session. PSL commands 

can also be assigned to the Soft buttons and the Power Pad to 

enable additional functions with a click of the mouse. 

What is new in 10.2? 

PowerTerm Pro Version 10.2 includes the following additions: 

 Support for Windows 8, Windows Server 2012 

PowerTerm Pro Features 

PowerTerm Pro features include: 

 32 and 64-bit support for XP/Vista/Windows 7/Windows 8; 

Windows Server 2008 / 2008 / 2008 R2 / 2012 

 File transfer for Xmode, Ymodem, Zmodem, Kermit, Ascii, Binary, 

and IND$FILE 

 Supports TCP/IP WinSock, DECnet (CTERM), and LAT 
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 Supports RS-232 (both direct and via modem), PPP/SLIP, SNA, 

and APPC connections 

 Supports Ethernet and Token ring networks. 

 PowerTerm Script Language (PSL) 

 String functions, including sub-string, index and concatenation 

 Enables you to save parameters for all sessions 

 High-level API enables access from other environments, such as 

C++, Visual Basic, and Power Builder. Also supports HLAPI, 

EHLLAPI, and WinHLLAPI. 

 Language support for most Western and Eastern European 

languages 

 Modem dialing 

 Multi-session capabilities 

 User programmable Soft buttons 

 Floating Power Pad with programmable buttons 

 Control of color selection and screen attributes 

 Supports printing including Auto Print mode and Slave Printing. 

Also supports Advanced Printing capabilities, including TN5250 

Host Print Transform, specifying the orientation of the printed 

output, setting values for CPI/LPI/FONT parameters, printer rows 

and columns. 

 Supports Kermit get command 

 Easy to use keyboard mapping 

 DDE communication for client or server 

 Compatible with Microsoft Office and Windows 2000 GUI 

 Web and email enabled 

 Script recorder for automation of tasks 

System Requirements 

 Microsoft Windows® XP or higher.  

 Connection parameters to a host computer.  

 Free space on hard disk:  

o PowerTerm Pro - 14 MB on disk  

PowerTerm Pro Enterprise - 72 MB on disk  

PowerTerm Pro Setup 

To enable PC-host interactions, define two sets of parameters: 

 Terminal parameters 
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 Communication parameters 

All parameters are saved in a Terminal setup file where the default is 

called ptdef.pts. Setup file extensions are: 

pts for the Terminal setup file 

ptc for the Communication setup file 

ptk for the Keyboard definitions file 

ptp for the Power Pad definitions file 

PowerTerm Pro provides the option to work with a single host or with 

multiple hosts. You can create different setup configurations for working 

with each host to enable each user a customized working environment. 

(For more information about specifying and saving parameters, see 

chapters Defining Emulations and Defining Connections.) 

Working with a Single Terminal Connection 

If you only need to connect to a single host connection, you should use 

the default terminal setup and communication file. PowerTerm Pro 

automatically uses the parameters in the setup file to start the system. 

Working with Multiple Terminal Connections 

If you are working with multiple terminal connections, you may need to 

use a different setup file for each emulation type. To create a setup file, 

you first need to define the terminal setup and communication 

parameters, and then save these parameters to a terminal setup file. 

Connection Overview 

Step 1: Start PowerTerm Pro 

Select Start menu | Programs | Ericom Software | PowerTerm Pro and click 

the PowerTerm Pro icon to launch the application. 

 When PowerTerm Pro is used for the first time, the PowerTerm Pro 

window is automatically displayed together with the Connect dialog. 

After the connection parameters have been defined, the Connect 

dialog will be displayed according to your selected option. 

PowerTerm Pro opens with the default terminal setup file. You can also 

open PowerTerm Pro using a customized setup file, or script. 

The major feature of the PowerTerm Pro window is its work area, which 

emulates a host terminal screen by displaying data entered on your 

terminal data received from the host.  

Step 2: Select a Terminal Emulation 

Select a terminal emulation for the current session or open a previously 

defined terminal setup file. 
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 To select terminal settings: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Emulation tab. 

3. Click one of the Terminal Types. The emulation type that you 

select changes the number of setup tabs and, for IBM 

emulations, the PowerTerm Pro windows display. 

4. Define terminal settings by clicking the relevant Property page 

tab and define setup parameters. 

5. Click OK. 

6. Save the settings by selecting File | Save Terminal Setup or 

Save Terminal Setup As. The file is saved. 

 To open a previously defined Terminal setup file: 

1. Select File | Open Terminal Setup. The Open File dialog appears. 

2. Select your desired setup file and click OK. 

Or, 

1. Select Communication | Connect. The Connect dialog appears. 

2. Click Setups. The Setup dialog appears. 

3. Type your desired setup file name or alternatively click the 

browse button and select the desired file in the Select File 

dialog. 

Step 3: Connect to Host 

After you have selected a terminal emulation, you need to define 

communication parameters for the current session, or select a previously 

saved session from the session list. PowerTerm Pro also provides an 

option to run a script file before you connect to a host 

 To connect to a host: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Define communication parameters or select a session with 

previously defined connection parameters from the Session list. 

3. Click Connect. A connection is established to a host computer. 

Step 4: Work with the Host 

Once you have connected to a host, PowerTerm Pro enables you to work 

as if you are working from a terminal.  PowerTerm Pro enables you to 

transfer files to and from a host as well as define print parameters, and 

print the terminal screen or data transferred from the host application. 
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Step 5: Exiting PowerTerm Pro 

PowerTerm Pro provides different options when exiting PowerTerm Pro. 

You can end a session automatically or be prompted with a confirmation 

message prior to closing a session. 

Select File | Exit or press both <Alt> and <X> on the keyboard. 

If you have changed terminal settings, PowerTerm Pro 

displays a warning message asking if you want to update the 

terminal settings file. The message will point to the name of 

the setup file currently loaded (ptdef.pts, if you use the default 

settings). Click OK to update the terminal settings, or No to 

cancel the latest changes and restore the default setup. 
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2. THE POWERTERM PRO INTERFACE 

The following is a list of the PowerTerm Pro window components as they 

appear from top to bottom. You can configure all the components, except 

the work area, to be displayed or hidden as will be convenient for you. 

 

Control Menu Box Provides standard Windows commands and enables 
you to redisplay the Menu bar. 

Title Bar Displays the application name. During a 
communication session, the ID type and/or host 

name is displayed next to the application name, for 

example, (A) PowerTerm Pro. 

Minimize button Closes the window, but not PowerTerm Pro. 

Click the PowerTerm Pro icon appearing in the 

Taskbar to reopen the PowerTerm Pro window. 

Maximize button Enlarges the window so that if fills the entire screen. 

The button is then replaced with the Restore button. 

This button is used to restore the window to its 

previous size. 
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Close button Closes the application. 

Menu Bar Contains dropdown menus, which enable the user to 

perform most PowerTerm Pro operations. 

Toolbar Contains icons, which can be used as shortcuts to 

access frequently used menu commands. 

Work Area Displays the data entered on the PC terminal or 

received from the host. During an emulation session, 

this work area emulates a terminal display. For IBM 

terminal types, the background of the work area is 

displayed in black. 

History Scroll Bar For non-IBM emulations only. 

Enables you to scroll up and down through the 

PowerTerm Pro window to view previously displayed 

data. Default: displayed. 

Soft Buttons Contains a series of buttons displayed above the 

Status bar that you can program to execute specific 

script commands. 

Communication LEDs Indicates communication activity. 

Emulator Type Displays the current terminal emulation type 
selected from the Emulation tab in the Terminal Setup 

dialog. 

Cursor Position 

Counter 

Displays the current line and column position of the 

text cursor in the work area. 

Caps Indicates whether the keyboard is in Caps lock 

mode. 

Hold Indicates whether the screen is in hold or frozen 

mode. 

Status Indicator – On 

Line, Off Line, Printer, 

Auto Prt 

The status indicator reads On Line when 

communication is established. 

The indicator reads Printer when data is 

transmitted with a printing request to the slave 

printer. The color of the indicator is the same as 

when PowerTerm Pro is in On Line mode, for 

example, the printer will appear in red if the 

system was On Line when the printing request 
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arrived. 

The data is sent to the screen and printer, and the 

indicator reads Auto Prt, when the terminal is in 

Automatic Printing mode. 

Macro/Message 

Display Area 

Displays system messages or a script sequence, as 

you type it in the work area. 

Window border and 

corners 

Changes the size of the window. The characters that 

appear in the work area are scaled up or down so 

that all the information always remains in view. 

Menu Bar 

The PowerTerm Pro Menu bar displays the main PowerTerm Pro functions 

in dropdown menus. The following is a brief description of each menu and 

the functions that it can perform.  

File Menu 

The File menu provides options to create, save and restore a terminal 

setup file, as well as to create an icon for your current PowerTerm Pro 

settings, also open keyboard and Power Pad settings and save them. You 

can also use this menu to set printing parameters, print, and to open a 

new instance of the PowerTerm Pro window. 

New Terminal Setup Restores the default parameters including the 

terminal display colors. If you have changed 

terminal parameters since the last save, PowerTerm 

Pro displays a warning message asking whether or 

not to save the latest changes. The message point 

to the terminal settings file currently loaded. 

Open Terminal Setup Opens the Open File dialog, which enables you to 

select and open an existing setup file. 

Save  Saves both terminal setup and communication 

parameters to the current setup file. 

Save As Opens the Save File As dialog, which enables you to 

save the current setup configuration under a 

different name. 

Save as Shortcut Opens the Save as Icon dialog to create an icon for 

the current PowerTerm Pro settings file. This 

enables you to start a session automatically with 

the desired parameters either by accessing the icon 

from the Windows Start menu or by double-clicking 
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it on your desktop. 

Open Keyboard File Opens the Open Keyboard File dialog, which enables 

you to open keyboard mapping settings that have 

previously been saved. 

Save Keyboard file Opens the Save Keyboard File dialog, which enables 

you to save separate keyboard mapping settings in 

a separate file and open them at a later date. 

Open Power Pad file Opens the Open Power Pad File dialog, which 

enables you to open Power Pad settings that have 

previously been saved. 

Save Power Pad File Opens the Save Power Pad File dialog, which enables 

you to save Power Pad settings in a separate file 

and open them at a later date. 

Print Screen Prints the contents of the work area, or the selected 

text. 

Print Setup Displays the Print Setup dialog, which contains 

printing parameters. Displayed parameters change 

according to the printer you selected. 

The Default Printer parameter enables you to send 

the output to the default printer selected. 

The Specific Printer parameter allows you to 

select one of the currently installed printers. 

Start/Stop Auto Print Prints all the data displayed in the work area. This 
option toggles between Start and Stop Auto Print. 

Form Feed Executes a form feed on the printer. 

Line Feed Executes a line feed on the printer. 

Send Mail Launches the default e-mail program and opens a 

new mail message, with or without attaching a 

desired setup file or screen capture. 

Exit All Sessions Exits all PowerTerm Pro sessions at once. 

Exit Exits the current PowerTerm Pro session. 

Edit Menu 

The Edit menu provides options to select, clear, and reverse text in the 
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PowerTerm Pro window and delete the contents of the history buffer. The 

Edit menu also provides standard editing commands (e.g. 

cut/copy/paste), in addition to commands that enable you to copy data to 

a file and copy data automatically to the clipboard. 

Select Screen Selects the contents of the entire work area. 

Clear Screen Captures the entire PowerTerm Pro screen and 

erases it. 

Clear History Deletes the entire contents of the history or scroll 

back buffer. This command is only available when 

the history buffer is in use. 

Reverse Screen For RTL languages only. 

Reverses the screen so that you can type from left 

to right or right to left, depending on the language 

you use. 

Cut for IBM emulations only. 

Cuts the selected text and places it on the 

clipboard. 

Copy Copies marked text to the clipboard when the 

Automatic Copy option in the Edit menu is not 

active.  

Paste Pastes the clipboard contents into the work area. 

Right-click sends data stored on the clipboard to 

the host. Equivalent to actually typing the contents 

of the clipboard on the host screen. 

Multisheet Print/Paste 

Setup  

Enables printing/pasting of data that does not fit 

onto one page, which Print Screen would 

accommodate. It is very useful for printing/pasting 

long records in the same screen format.  

Copy as Bitmap Copies the screen or screen selection as a bitmap. 

By default the screen capture will appear in color 

but you can also save it in black and white. 

The screen capture can also be automatically 

copied into an untitled email in your Outlook 

program. 

Copy to File Copies selected information to a file. If no text is 

selected, the entire screen is written to the file. 
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Automatic Copy Automatically copies selected text to the clipboard 
with no need to select the Copy option. 

Copy Right to Left For RTL languages only. 

Reverses the order of the letters in the work that 

was copied to the clipboard when displayed. 

View Menu 

The View menu provides options to allow you to hide or show the Menu 

bar, Toolbars, Status bar and Function Buttons.   

Menu Hides/ shows the Menu bar. 

To restore it, right-click on the title bar and choose 

Restore Menu. 

Toolbars Hides/Shows the Toolbar. 

Status bar Hides/Shows the Status Bar. 

Function Buttons Hides/Shows the Soft buttons. 

Terminal Menu 

The Terminal menu provides options to define and reset connection 

parameters, set the system to be online or offline, and freeze or unfreeze 

the screen. You can also select the fonts and languages (in versions that 

support it) to be displayed in the PowerTerm Pro window. 

Setup Opens the Terminal Setup dialog in which you can 

define settings for terminal emulation. This 

dialog contains different tab pages that enable 

you to define all aspects of your terminal setup. 

Colors Displays color parameters for data displayed in 

the work area. 

PowerTermFonts Displays the default PowerTerm fonts. These 

fonts are scaleable so that if the window shrinks, 

the fonts will shrink in relation to the size of the 

window. 

System Fonts Displays the PowerTerm Pro window with system 

fonts. These fonts remain the same size, no 

matter what the size of the window when 
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Unscaled Screen (from the Display Property 

page) is selected. When you select your own 

system fonts, you can only select fixed size font. 

Reset Resets the VT terminal defaults. This command 

does not apply to PowerTerm Pro's exclusive 

terminal parameters (such as color). 

Online Sets the system to be online or offline. 

Hold Screen Stops communication and freezes the screen. To 

unfreeze the screen, reselect the command. 

Multisheet Print/Paste 

Setup 

Enables printing/pasting of data that does not fit 

onto one page, which Print Screen would 

accommodate. It is very useful for 

printing/pasting long records in the same screen 

format. 

Hotspots Setup Specifies which menu rows will be activated as 

hotspots. 

Language option Selects the user interface language to appear in 

English, German, French, Italian, Spanish, 

Greek, or Czech. 

Communication Menu 

The Communication menu provides options to define and modify the 

communication (session) parameters, and to connect/disconnect a 

communication session. The Communication menu also provides file 

transfer options. It enables you to set and clear Data Terminal Ready 

(DTR) and Ready to Send (RTS) signals as well as select a modem from a 

list of existing modems. 

Connect/ Disconnect Displays the Connect dialog, which enables you to 

define session parameters and connect to a host. 

Modify Connection Displays the Modify Connection dialog, which 

enables you to modify connection parameters for 

COM type communication. 

Modem Setup Opens the Modem Setup dialog, which enables you 

to select a modem from a list of existing modems 

and initialization strings. It also enables you to add 

customized modem definitions and edit the 

initialization string provided. 
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Reset Communication Resets the communication port for COM type 

communication. 

Run FTP Launches the PowerTerm Pro FTP client, capable of 

transferring files from one computer to another. 

Receive File Receives a file from the host via Kermit, Zmodem, 

Ymodem, Xmodem, Ascii or Binary. 

Send File Sends a file to the host via Kermit, Zmode, 

Ymodem, Xmodem, Ascii or Binary. 

SSL Setup Implements SSL security in your connections. 

Data File Transfer Launches As400 Data File Transfer Client 

Utilities Displays signal options: 

Dial, enables you to dial a specific phone number 

for COM type communication. 

Break, sends a break for COM type communication. 

Equivalent to <Ctrl>+<Break>. 

Set/Clear DTR, sets/clears DTR (Data Terminal 

Ready) signals. 

Set/Clear RTS, sets/clears RTS (Ready To Send) 

signals. 

AUX: Modify Connection, enables two-way slave 

printing to a serial printer. 

Sessions Menu 

The Session menu lists all the active PowerTerm Pro sessions and enables 

you to toggle between them. The first session generated is automatically 

named Session A, the next Session B, and so on. 

Options Menu 

The Options menu enables you to map your keyboard and define the 

Power Pad display. It also enables you to store a session in a log file as 

well as provides options to customize your PowerTerm Pro screen. 

Keyboard Map Displays the Keyboard Mapping dialog, which 

enables you to map your PC keys to host keys on 

the terminal keyboard. 
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Power Pad Setup Displays the Power Pad Setup dialog, which 

enables you to adjust the number of buttons in 

the Power Pad. 

Start/Stop Trace Stores received data in the Trace.log and 

Capture.log files. These files are located in the 

PowerTerm Pro folder. The menu command 
toggles between Start Trace and Stop Trace. 

Capture.log stores raw data, as received from the 

host. 

Trace.log stores formatted data with readable 

escape sequences.  

Hide/Show Power Pad Hides/Shows the floating Power Pad. 

Customize Enables you to customize the menu bar and the 

toolbars. 

General Settings Enables you to determine how you want to 

access Ericom Software Web pages, the Script 

Editor, and other External Applications.  

Insert Object Hides/Shows the Soft buttons. 

Show Full Screen Hides/Shows the Status Bar. 

Tools Menu 

The Tools menu allows you to create macros or VBA scripts to be run in 

the PowerTerm Pro Enterprise. 

Macro Creates a new name for a macro and then 

launches the VBA editor. 

User Tools Customizes the Tools menu with any particular 

application. 

Script Menu 

The Script menu provides options to create and run PSL commands. 

Run Script Displays the Run Script dialog, which enables you 

to select and run a script. 
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Edit Script Displays the Edit Script dialog, which enables you 

to edit an existing script or to create a new one. 

Script Command Displays the Script Command dialog, which enables 

you to run individual script commands. 

Start/Stop Script 

Recording 

Records a script automatically. After requesting 

Start Script Recording, the manual operations you 

perform in the emulation screen are recorded into 
a script file until you choose the Pause or Stop 

Script Recording command. 

Pause/Continue Script 

Recording 

Pauses or resumes the script recording. This 

enables you to exclude certain operations from 

recording. 

Activate Recorded 

Script 

Activates the script currently recorded in memory. 

The script is saved in memory while the 

PowerTerm Pro session is active. 

Save Recorded Script Enables you to save a script from memory to a 

specific file to be used at a later date. 

Window Menu 

The Window menu allows you to open a new terminal window which you 

can use to connect to the same or different host. 

 

Help Menu 

The Help menu provides options for accessing the PowerTerm Pro online 

help and product and license management information. 

Help Topics Accesses the table of contents for the 

PowerTerm Pro online help. 

Tip of the Day Displaying useful tips and hints. 

Ericom Software on the 

Web 

Links to Ericom Software's products. 

About PowerTerm Pro Displays product and contact information. 
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Toolbar 

The PowerTerm Pro Toolbar contains icons, which provide shortcuts to 

frequently used menu options. The following is a brief description of the 

icons. You can also place the cursor over the icon to display its 

description as a tool tip. 

 Some emulation types display only part of the icons.  

Hold Screen/Release Hold  
 

 

For non-IBM emulations only. 

Suspends and resumes 

communication with the host. After 

you click the Hold Screen icon, it 

turns red. After you click the icon 

again, it changes back to green and 

update of the PowerTerm Pro 

window resumes. 

Equivalent to Terminal | Hold Screen. 

Connect/Disconnect 

 

Opens the Connect dialog where 

you define session communication 

parameters and connect to the 

host.  

Disconnects an open session. 

Equivalent to Communication | 
Connect (Disconnect) 

Cut  

 

For 5250 emulations only. 

Cuts the selected text. 

Equivalent to Edit | Cut. 

Copy to Clipboard  

 

Copies the selected data displayed 

in the work area to the clipboard. 

Equivalent to Edit | Copy. 

Paste from Clipboard 

 

Pastes data from the clipboard to 

the host application. 

Equivalent to Edit | Paste. 

Print 

 

Prints selected text from the history 

buffer or the entire contents of the 

work area. 
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Equivalent to File | Print Screen. 

Start/Stop Auto Print 

 

For non-IBM emulations only. 

Prints incoming data as it is 

displayed on the screen. Click the 

icon again and the automatic 

printing stops. 

Equivalent to File | Start Auto Print. 

Dial 

 

For non-IBM emulations. 

Dials a specific telephone number 

for COM type communication. 

Equivalent to Communication | 

Utilities | Dial. 

Start/Stop Script 

Recording  
Records manual operations in script 

form. Click the icon again and the 

script recording stops. 

Equivalent to Script | Start Script 

Recording. 

Change to 80 Columns 
 

For non-IBM emulations only. 

Specifies an 80-column display for 

the work area. 

Equivalent to Terminal | Setup | 

Display. 

Change to 132 Columns 

 

For non-IBM emulations only. 

Specifies a 132-column display for 

the work area. 

Equivalent to Terminal | Setup | 

Display. 

Terminal Setup 

 

Displays the Terminal Setup dialog in 

which you can define terminal setup 

parameters. 

Equivalent to Terminal | Setup. 

Colors 

 

Displays the Colors dialog box in 

which you can define the color of 

data in the work area. Equivalent to 
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Terminal | Colors. 

 

Keyboard Mapping 

 

Opens the Keyboard Mapping dialog 

in which you can map PC keys to 

host keys. 

Show/Hide Power Pad 

 

Displays the Power Pad. Click the 

icon again and the Power Pad 

closes. 

Equivalent to Options | Show Power 

Pad. 

Full Screen 
 

Displays the PowerTerm Pro on a 

full screen. Equivalent to Options | 

Show Full Screen. 

Help Contents 

 

Displays the PowerTerm Pro online 

help. Equivalent to Help | Contents. 

About PowerTerm Pro 

 

Displays product information. 

Equivalent to Help | About 

PowerTerm Pro.  

New Terminal Window 
 

Opens a new instance (window) of 

PowerTerm Pro. 

Session 
 

Click the session's icon to bring it to 

the front.  

Hot Keys 

Hot keys are keyboard shortcuts that you can use instead of selecting 

menu commands. These hot keys refer to your standard PC keyboard 

keys, before they are mapped to terminal keys. Once hot keys are 

mapped, they lose their original function and reflect the newly mapped 

terminal key. For example, if you map <Alt F4> to the <Backspace> key 

on the terminal keyboard, it performs the function of a <Backspace> key. 

The following table lists the default PowerTerm Pro hot keys: 

Alt F4 Exit 

Alt F6 Open a new terminal window 
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Alt F9 Activate script 

Ctrl+Alt+F9 Start/Stop script recording 

Ctrl+Shift+P Activate recorded script 

Alt F10 Select screen 

Alt F11 Clear screen 

Alt F12 Reverse screen. 

IBM 5250 emulations not included. 

Scroll Lock Hold screen 

Pause Change the cursor shape 

Ctrl Up Arrow Scroll up one line 

Ctrl Down Arrow Scroll down one line 

Ctrl Home Scroll to the beginning of the history buffer 

Ctrl End Scroll to the end of the history buffer 

Ctrl Page Up Scroll up one page 

Ctrl Page Down Scroll down one page 

Shift+Ctrl+X Switch focus to session X 

X is the session letter (A…Z) displayed in the 

PowerTerm Pro windows Title bar. 

Ctrl+Spacebar Switch to next active session 

Connection Dialog 

 The parameter options change according to emulation and Session 

Type (protocol) selected.  
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Session Type Parameters 

TELNET Uses the Telnet protocol over TCP/IP for network 

communication. 

Specify the host computer name or the IP address in 

the Host Name text box. 

Specify the TELNET Port number (default 23). 

The winsock.dll file must be in the search path. 

COM Uses serial communication with the PC's COM ports. 

Define the Baud Rate, Port Number, Parity, Stop Bits and 

Flow Control 

Optionally, specify a telephone (Dial) number. 

Optionally, specify if you want to check for parity 

errors. 

BAPI For TCP/IP connections with parameters similar to those 

of TELNET. 

Verify that the BAPI support software is installed on 

your PC before you use this option. 
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CTERM Uses the DIGTAL CTERM protocol for network 

communication with a remote or local VAX/Open VMS 

host via DIGITAL PATHWORKS 32. 

Specify the host computer name in the Node Name 

field. 

LAT Uses DIGITAL LAT protocol for network communication 

with a VAX/Open VMS host via DIGITAL PATHWORKS 32. 

Specify Service and a Password (if required). 

TN3270 TELNET for 3270 emulations. 

Select Use TN3270 Protocol if you want to work with 

TELNET SNA extensions. 

Specify the LU Name of the host (LU name or LU pool). 

MS SNA Server For connection via Microsoft SNA Server. 

Specify the LU Name (or LU pool). 

NWSAA (IPX) For connection via IPX to Novel Netware for SAA. The 

Service Name is the same as Novel's Profile. 

Select an LU Category. 

Specify an asterisk (*), as the Server Name and 

PowerTerm Pro will connect to the appropriate Netware 

for SAA server. 

NWSSA (TCP/IP) Same as previous for TCP/IP connection. 

Specify the server's IP address or host name in the 

Server Name field. 

TN5250 TELNET for 5250 emulations. 

APPC 
Specify the appropriate AS/400 names in Host Name 

and Device Name fields. 

Select Auto SignOn if you want to skip the sign on 

stage. 

RLOGIN Uses the RLOGIN protocol over TCP/IP for network 

communication. 

Specify the host computer name or IP address in the 

Host Name field. You can also specify the port number 

in the Host Name field. 

TAPI 
Enables PCs running Microsoft Windows to use 

telephone services. 

SUPERLAT This is a version of the LAT protocol for network 

communication with a VAX/Open VMS host, which 
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requires Meridian's SUPERLAT. 

Specify Service Name and Password (if required). 

NSVT For HP emulations. 

Terminal Setup Dialog 

 The emulation type that you select changes the tabs (property pages) 

displayed in the Terminal Setup dialog and their options. 

 

Property Page Description 

Emulation Displays supported terminal emulations and enables you to 

select a terminal type. 

General Defines parameters for the terminal emulation type. 

Display Defines display settings for the PowerTerm Pro window. 
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Keyboard Defines keyboard setup parameters. 

Printer Defines printer parameters. 

Tabs For VT emulations only. 

Defines tab stops in the work area. 

Colors Defines color settings for the PowerTerm Pro window. 

Preferences Defines parameters that determine PowerTerm Pro behavior 

and automate processes. 

General Property Page 

Non-IBM Emulations 

 

Option Description 
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Terminal ID Determines the ID returned by the emulation program to 

the host. Verify that you select an ID that the host 

application/system recognizes. 

NRC Set Determines the communication and keyboard character set 

for 7-bit data only.  

UPS Set Determines the communication and keyboard character set 

for 8-bit data only. 

8 bit Controls Enables when UPS Set is specified as Code Page 437 and 

up.  

Disable, determines if 0x80 to 0xAF are displayed 

characters. 

Enable, determines if 0x80 to 0xAD are control characters. 

0x9B, all characters are displayed characters except 0x9B, 

which is a control character. 

Online Equivalent to Terminal | On Line (Off Line). 

New Line Determines whether the <Enter> key generates only a 

carriage return or a carriage return/line feed combination. 

Use 8 Bit Data 

Characters 

Select this parameter if the communicated data is in 8-bit 

character format. Clear it for 7-bit characters. When 

cleared, the 8th bit is truncated. If you receive 7-bit data, 

you can convert it to 8-bit data for printing on the slave 

printer. 

User Defined 

Keys (UDK) 

Determines whether applications on the host system can 

override your user-defined keys (UDKs) when you have 

defined a function key that conflicts with how the host 

wants to use this key. UDKs let you use a single key for 

multiple keystrokes. To program the 15 UDKs, 256 bytes 

are available. The key definitions are loaded sequentially 

(from F6 to F20) so that if you reach the 256-byte limit, 

more definitions cannot be loaded. 

Locked, prevents UDKs from being overridden. 

Unlocked, allows UDKs to be overridden. 

Cursor Keys For VT emulations only. 

Determines the behavior of the four arrow keys. 
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Normal, generates ANSI-standard control sequences for 

moving the cursor. 

Application, generates customized application program 

functions. 

Keypad For VT emulations only. 

Determines the effects of the numeric keypad on your 

keyboard. 

Numeric, keypad keys insert numbers. For example, 

pressing <7> on the numeric keyboard is the same as 

typing '7' on the keyboard. 

Application, keypad keys generate control sequences that 

can be used by some applications. 

(Use) NumLock, enables or disables the NumLock keyboard 

function in respect to the above Numeric and Application 

modes: 

"NumLock" checkbox not checked, the NumLock key is a 

regular emulation key that has been mapped/defined as 

PF1 (default) or any other key. The NumLock key will not 

change the NumLock keyboard status. 
"NumLock" checkbox checked: 

Numeric Keypad Mode, the NumLock key toggles between 

function states: enabling numeric keys (when lit) or arrow 

keys (when not lit). 
Application Keypad Mode, the NumLock key toggles 

between function states. Enabling numeric keys (when lit) 

or application keys (when not lit). 

Cursor coupling Vertical, determines whether the user window pans with 

the cursor when the cursor moves past the top or bottom 

border of the user window. 

Page, determines if a new page appears in the display 

when the cursor moves to a new page. 

Status Line None, displays an emulation screen without the status line. 

Indicator, displays the status line. 

Host Writeable, displays the status line sent by the 

host. 

Label Line For ASCII emulations only. 

Displays a status line on the top and bottom line of the 

emulation screen. 
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IBM Emulations 

 

Option Description 

General ID, determines the ID returned by the emulation 

program to the host. Make sure you select an ID that 

the host application recognizes. 

Unscaled Screen, when this parameter is cleared, the 

characters appearing in the work area are scaled. A 

change in the size of the desktop causes the fonts to 

shrink in relation to the size of the window. Select this 

parameter if you want to disable this feature. 

Show Respone Time, displays the number of seconds 

that elapsed between the time data was sent to the host 

and the host response time. 

Cursor Ruler Select Visible to display full-screen, vertical or horizontal 

lines as a cursor ruler (cross hair guide). 

Cross Hair, displays the cursor ruler as a horizontal and 

vertical line. 
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Horizontal, displays the cursor ruler as a horizontal line 

only. 

Vertical, displays the cursor ruler as a vertical line only. 

Cursor Controls the cursor appearance and functionality: 

Block/Underline/Visible/Blink, controls the cursor 

appearance. 

Ins Change, when selected it enables toggling the cursor 

between underline and block appearance, by clicking the 

Ins (insert) button. 

Appearance Power GUI, displays data in a window with 3D look & 

feel. Use system fonts larger than 10 pt. for optimized 

results. 

Show Frame, places a frame around the text area of the 

emulation. 

HLLAPI Names The names of an hllapi session can either be short or 

long. 

Short and Long, enables you to specify the short and 

long hllapi names. 

Code Page Specifies the host and PC (keyboard) character sets. 

Alternate Size Enable, select to override the terminal alternate size 

with a specific size. 

Rows/Columns, type the required number. 

Display Property Page 

For non-IBM emulations only. 
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Option Description 

General Reverse Display Colors, reverse the text and background colors 

in the work area. 

Unscaled Screen, when this parameter is cleared the characters 

appearing in the work are scaled. A change in the size of the 

desktop causes the fonts to shrink in elation to the size of the 

window. Select this parameter if you want to disable this 

feature. 

Autowrap Characters, wraps words at the end of a line and the 

cursor moves to the next line. 

History Scroll Bar, displays the vertical history scroll bar along 

the right edge of the PowerTerm Pro screen. This enables you to 

scroll through the data displayed previously on the screen. If 

the host transmits during scrolling, the display automatically 
scrolls back to its current position. NOTE Selecting Clear History 

from the Edit menu can erase the History buffer. 

Cursor 

Ruler 

Select Visible to display full-screen, vertical or horizontal lines 

as a cursor ruler (cross hair guide). 
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Cross Hair, displays the cursor ruler as a horizontal and vertical 

line. 

Horizontal, displays the cursor rules as a horizontal line only. 

Vertical, displays the cursor ruler as a vertical line only. 

Cursor Controls the cursor appearance and functionality: 

Block/Underline/Visible/Blink, controls the cursor appearance. 

Ins Change, when selected, it enables toggling the cursor 

between underline and block appearance by pressing the Insert 

key. 

Ctrl 

Characters 

Display, displays the control characters. 

Interpret, performs the regular terminal behavior as affected by 

control characters. 

Power GUI Displays data in a window with 3D look & feel. Use System fonts 

larger than 10 pt for optimized results. 

Show 

Frame 

Places a frame around the text area of the emulation. 

Dimensions Determines the number of characters (columns) per displayed 

line, and the number of lines to be displayed in the work area. 

Characters are scaled according to the selected values. Type a 
different value in the Other box instead of choosing one of the 

standard options (80 and 132). 

Limit Font Size 

Allows PowerTerm Pro fonts to use only the optimal font 

size, especially for frames. 

Note: Not recommended for normal text on large screens. 

Scrolling Determines the pace at which data is displayed in the work area 
as it arrives. If you select Jump, you should determine the Jump 

Scroll Speed that is measured in number of line units. The 

higher the value, the faster the scrolling. 

Unlimited, displays data without delaying communication. 

Page, scrolls data by full screens. 

Smooth, is equivalent to a Jump Scroll Speed of 1. 

Enable Soft 

fonts 

Enables you to work with VT soft fonts. The fonts will be loaded 

from the host application. 
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Keyboard Property Page 

Non-IBM Emulations 

 

 

Option Description 

Capslock Mode Determines the behavior of the Caps Lock key. 

Caps (Unix), locks alphabet keys on main keypad in 

uppercase. 

Shift, locks alphabet and numeric keys on main 

keypad in shift setting. Pressing the shift button on 

your keyboard will release shift-lock mode. 

Reverse (Win), Same behavior as Caps Lock, however 

pressing the shift button on your keyboard reverses 

the caps operation. 

Always On, enables you to toggle to a different 

application and turn Caps Lock mode off. On return to 

PowerTerm Pro it will automatically revert to Caps Lock 

on. 

Backspace Key Determines whether the <Backspace> key sends Delete 
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Sends Delete or an actual Backspace. 

Auto Repeat Repeatedly displays the character whose key is being 

continuously pressed down. 

Numpad Decimal 

sends Comma 

Specifies that the Numeric Pad's decimal key sends a 

comma instead of a decimal. 

Use Emulator Alt 

Keys 

Select to make an <Alt> key perform the terminal 

operation even if Windows OS has an operation mapped 

to the same key. 

Local Echo Determines whether keyboard input is displayed 

(echoed) on your screen. 

Select, to display the keyboard input even if the host 

system does not echo your input. 

Clear, to send the keyboard input to the host system 

without being displayed on the screen (unless, 

invariably, the host system automatically echoes the 

characters). 

Use VT Keyboard 

Mode 

Changes your keyboard into a Digital VT keyboard mode. 

In this mode, the PC keyboard operates as close to a VT 

keyboard as possible, and takes full advantage of LK450 

Digital keyboards. 

Answerback 

Message 

Specifies an answerback message and its display. 

Clear, deletes the message. 

Conceal, hides the message without being deleted. 

Auto Answerback Determines whether the terminal automatically sends the 

message to the host system after you make the 

connection. This is useful if your answerback message is 

a command to the host system. 
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IBM 3270  Emulations 

 

Option Description 

Capslock Mode Determines the behavior of the Caps Lock key. 

Caps (Unix), locks alphabet keys on main keypad in 

uppercase. 

Shift, locks alphabet and numeric keys on main 

keypad in shift setting. Pressing the shift button 

on your keyboard will release shift-lock mode. 

Reverse (Win), Same behavior as Caps Lock, 

however pressing the shift button on your 

keyboard reverses the caps operation. 

Always On, enables you to toggle to a different 

application and turn Caps Lock mode off. On return 

to PowerTerm Pro it will automatically revert to Caps 

Lock on. 

Backspace Deletes Select to delete characters by pressing the 
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Backspace key on your keyboard. 

Auto Repeat Repeatedly displays the character for which its key is 

being continuously pressed down. 

Lock Numeric Field Determines whether the keyboard is locked when 

you try to enter non-numeric data. 

Typeahead Types data ahead, before the host responds. 

Automatic reset Key If the Keyboard is locked, a reset key sequence is 

generated prior to when you click on the tab key to 

advance to the next field. 

Numpad Decimal 

Sends Comma 

Determines whether the Numeric Pad sends a 

comma instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key perform the terminal 

operation even if Windows OS has an operation 

mapped to the same key. 

Non SNA System Wait Determines whether the System Wait in the IBM 

3270 emulation will act as a System Wait in a non-

SNA terminal. 
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IBM 5250 Emulations 

 

Option Description 

Capslock Mode Determines the behavior of the Caps Lock key. 

Caps (Unix), locks alphabet keys on main keypad in 

uppercase. 

Shift, locks alphabet and numeric keys on main 

keypad in shift setting. Pressing the shift button on 

your keyboard will release shift-lock mode. 

Reverse (Win), Same behavior as Caps Lock, 

however pressing the shift button on your keyboard 

reverses the caps operation. 

Always On, enables you to toggle to a different 

application and turn Caps Lock mode off. On return to 

PowerTerm Pro it will automatically revert to Caps Lock 

on. 

Backspace Deletes Select to delete characters by pressing the Backspace 

key on your keyboard. 
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Auto Repeat Repeatedly displays the character for which its key is 

being continuously pressed down. 

Typeahead Types data ahead, before the host responds. 

Automatic reset 

Key 

If the Keyboard is locked, a reset key sequence is 

generated prior to when you click on the tab key to 

advance to the next field. 

Numpad Decimal 

Sends Comma 

Determines whether the Numeric Pad sends a comma 

instead of a decimal. 

Use Emulator Alt 

Keys 

Select to make an <Alt> key perform the terminal 

operation even if Windows OS has an operation mapped 

to the same key. 

 

Sound:  

Terminal Sound Setup 
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Option Description 

Sound Events Determines the behavior of the sound. 

Key Click, Emits a click sound when a key on the keyboard is 

pressed. 

Warning Bell, Determines whether the terminal sounds a 

bell tone when receiving the "bell" (ASCII 7) character. For 

operating errors, mail messages, etc. 

Margin Bell, Determines whether the terminal sounds a bell 

tone when the cursor reaches the right margin. 

Sound Generation Allows the user to choose whether to play sound through the 

sound card (speakers) or through the internal PC speaker. 

Use Sound Card, will play sounds through the speakers using 

the sound card. When using the sound card, PowerTerm will 

play keyclick.wav and warning.wav.    

Async, determines whether to use synchronic and 

asyncronic sound. Asynchronic sound allows the 

application to continue executing while the sound is being 

generated. If the sound is not played asynchronously (that 

is, sychronously) the application will wait until the entire 

sound has finished playing before executing the next 

statement. 

Use Internal Speaker, will play sound through the internal 

speakers. 

Key Click 

Properties 

Specifies the sound duration and pitch for the Key Click. 

 

Duration (ms), determins the length of time the Key click 

sound will be played (in Mili- seconds) 

Pitch (Hz), determines the perceived frequency of a sound 

between 1 to 10000 Hertz). 

*  For playing the warning bell, PowerTerm will always use 

the following settings: 

Duration: 750 

Pitch (frequency): 150 

Option Description 
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Printer Property Page 

 

 

Option Description 

Print Device Allows you to select a printing output channel. 

None, no destination was assigned. The Device Name is 

disabled. Printer data is received by the terminal, but 

discarded (not printed). 

Device, sends printing to the device you designate in the 

Device Name text box. This can be a device such as 

COM1, COM2, COM3, etc. in the Device Name text box, 

you can also specify communication parameters. For 

example: COM 1:9600,8. 

Network, sends printing to the network printer. You must 

hen perform the following: 

1. Select File | Print Setup. 

2. Select Network from Port field. 

3. Type UNC (Universal Naming Convention) in the Net 

Path. For example, \\net1\hp4000 

File, sends printing to the file specified in the File Name 

text field. 

AUX, sends printing to the auxiliary port. 

file://net1/hp4000
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Device Name The available printing devices are: LPT1: (default) COM 

x: 

File Name Specify if you want Append or Overwrite mode. 

NOTE: lpt1 is a saved word and cannot be used as a file 

name. 

Use Form Feed Adds a form feed (page eject) after each printing job. 

This depends upon the available connections on your PC. 

Print Line 

Graphics As Text 

Converts line graphics to text. This speeds up printing on 

a slow dot-matrix printer. 

LF->CRLF Adds a line feed after each single carriage return (one 

that has no line feed following it) when in slave printing 

mode. 

Print Screen Data 

Conversion 
Converts data to Host or UTF-8 character sets or prints 

in Graphics mode. 

None, does not convert data. 

NOTE: Text mode is designated by selecting Host, UTF-8 
character sets or None. 

Slave Printer Data 

Conversion 
Converts data to Host or UTF-8 character sets or prints 

in Graphics mode. 

None, does not convert data. 

NOTE: Text mode is designated by selecting Host, UTF-8 

character sets or None. 

Slave Printer Job 

Delimiter 

For non-IBM emulations only. 

Specifies the job delimiter character that will divide the 

data into print jobs, thus disabling the escape sequences 

arriving from the host application. 

Delay for Print 

Closing 

The command to close the printer queue is delayed by 

the number of seconds that you determine. This 

command only takes effect if no open command is issued 

in the meantime. Important for printing to cut sheet 

printers (for example, inkjets/lasers) and network 

printers. 
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Advanced Printing Setup 

 

Option Description 

Printer Type For text printing only. 

Specifies the destination printer. Edit enables you to edit 

the printer configuration file. 

Margins Specifies the space between the edge of the printout page 

and the border of the printing. 

Font For text printing only. 

 

Printer default font and size will be applied to the output 
when Ignore is selected. Otherwise, User input will be 
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applied. 

Use Host Value (5250 printer only) – AS/400 selects the 

font. 

CPI (Characters 

per Inch) 

User defined, You select the CPI. 

Use Host Value, (5250 printer only) AS/400 selects the 

font CPI. You need to select None for Slave Printer 

Data Conversion. 

Ignore, Does not send escape, i.e. prints in the printer 

default font (typically 10 CPI). 

Auto, Default printer values are used. 

Auto (Printer sizes), Fits to page but uses only the predefined 

printer font sizes (i.e. 5,10,10,12,15,17,20 CPI). 

  

LPI (Lines per 

Inch) 

User defined, You select the LPI. 

Use Host Value, (5250 printer only) AS/400 selects the 

font LPI. 

Ignore, Does not send escape, i.e. prints in the printer 

default font (typically 6 LPI). 

Auto, Default printer values are used. 

Auto (Printer sizes), Fits to page but uses only the predefined 

printer font sizes (i.e. 2,3,4,6,8,10 LPI). 

 

Printer 

Columns/Rows 

For graphic printing only. 

Determines the number of printer columns/rows in the 

output. Select Ignore to apply the number of columns on 

your emulation screen to the output. 

Page Type for 

Text Printing 

Specifies the page type (for example, A3, A4, A5 etc.) 

Form Feed Defines the form type of the printer. PowerTerm Pro 

provides the following three types: 

AUTOCUT, single-cut sheets are automatically fed into the 

printer. Most printers require a sheet feed attachment. 

CONT, continuous sheets are used by printers that have a 

tractor feed attachment on the device. 

CUT, single-cut sheets are manually fed into the printer. 
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Orientation Specifies the orientation of the printed output. The default 

depends on your printer' settings. Options are:  

Host, receives escape sequence from the host about the 

page orientation.  

Auto, if the width is greater than the length then it will 

print in Landscape otherwise in Portrait orientation. 

Ignore, does not send any escape sequence. 

Portrait, A vertical page orientation in which the page 

height is greater than the page width. 

Landscape, A horizontal page orientation in which the 

page width is greater than the page height. 

Enable AS/400 

Host Print 

Transform 

For IBM 5250 printer emulations only. 

Enabled, pass through (transparent) mode. The host sends 

(ASCII) command and text directly to the printer. Non-

graphic printing only. Disabled, the host sends (EBCDIC) 

5250 SCS format commands and text to the emulation. The 

emulation, in turn, translates to printer specific commands. 

Customizing 

Object 

Specifies the object name that you have previously defined 

on the AS/400. Enabled only for "Other" printer models. 

Library Specifies the customizing object's library on the AS/400. 

Enabled only for "Other" printer models. 

Drawer 1 Specifies the size for the paper in Paper Source 1. 

Drawer 2 Specifies the size for the paper in Paper Source 2. 

Envelope 

Hopper 

Specifies the size of the envelope. 

Supports ASCII 

Code-Page 899 

Specifies whether the printer has Code Page 899 installed. 

Tabs Property Page 

For VT emulations only. 
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Options Description 

Tabs Stops Click anywhere within the Tab Stops area to set tab stops 

manually. 

Set Every Sets a tab stop in increments of a number typed in the 

adjacent text field. 

Clear All Clears all tab stops. 
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Colors Property Page 

Non-IBM Emulations 

 

Option Description 

Preview Box Shows the result of your selections. 

Enable Underline Enables underlined characters. 

For data transmitted from the host with the Underline 

attribute, clear to disable displaying data with the 

underline. 

Enable Blink Enables blinking. 

For data transmitted from the host with the blink 

attribute, clear to disable blinking data.  

Coloring method 

dropdown list 

Default, uses the default color type for each emulation 

type: 

VT and Siemens – Attribute & ANSI colors 

ANSI and HP – ANSI colors 

All others – Attribute colors (i.e. not affected by setting 
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to a different value). 

Attribute, colors based on the attributes. For example, 

you can select different colors for bold, for underline, 

and for bold/underline. 

ANSI, colors based on host-defined colors. For 

example, the host sends "red foreground on blue 

background" however you can select the default ANSI 

color. Different attributes do not affect colors. 

Attribute & ANSI, uses both Attribute and ANSI colors as 

explained above. 

ANSI 8 Color Mode For ANSI emulations only. 

A regular terminal has 16 colors (8 colors with the Bold 

attribute applied to them and 8 colors without the Bold 

attribute applied to them). The Background color never 

has the bold attribute (therefore it is "dark") while the 

Text (foreground) is always mapped to the color with 

the Bold (bright, light) attribute. 

Non-selected, each entity (text, background) can have 

any of the 16 colors mapped to them. 

Selected, each entity (text, background) can have any 

of the 8 colors mapped to them. 

Color Frame Select to draw a color frame on the screen. 

Select Attribute Select the attribute for which you want to define 

foreground and background colors. Attributes change 

according to the emulation type you selected in the 

Connection properties dialog. Generally, the attribute 
of the entire screen is Normal. The color for the Normal 

attribute determines the color of the entire work area. 

Text Select the color that will apply to the text (foreground) 

of the display. 

Background Select the color that will apply to the background of the 

text. 
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IBM Emulations 

 

Option Description 

Preview Box Shows the result of your selections. 

Enable Underline Enables underlined characters. 

For data transmitted from the host with the Underline 

attribute, clear to disable displaying data with the 

underline. 

Enable Blink Enables blinking. 

For data transmitted from the host with the blink 

attribute, clear to disable blinking data. 

Column Separator For IBM 5250 emulations only. 

Displays a period as a column separator in fields with 

the column separator attribute. 

Color Frame Select to draw a color frame on the screen. 
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Select Attribute Select the attribute for which you want to define 

foreground and background colors. Attributes change 

according to the emulation type you selected in the 

Connection properties dialog. Generally, the attribute 

of the entire screen is Normal. The color for the Normal 

attribute determines the color of the entire work area. 

Text Select the color that will apply to the text (foreground) 

of the display. 

Background Select the color that will apply to the background of the 

text. 

Preferences Property Page 

 

Option Description 

On PowerTerm 

Start 

Auto Connect, establishes a connection immediately with 

the parameters saved in the terminal parameters file. 

Show Connect Dialog Box, does not establish a 
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connection immediately, rather the Connect dialog 

opens and enables you to select required connection. 

Do not Connect, opens only the PowerTerm Pro window. 

Window Title Specifies a customized name that appears on the title 

bar. 

History Buffer Specifies the size of the buffer in which data is stored, 

by selecting an option from the dropdown list. 

On PowerTerm 

Exit 

Save Terminal Setup, the new terminal parameters (if 

you changed them during the session) are saved to the 

current terminal setup file. 

Confirm Save, terminal parameters are not saved 

automatically. PowerTerm Pro displays a dialog where 

you can decide whether or not to save any changes you 

did to the settings during the session. 

Confirm Disconnect Session, if you close PowerTerm Pro 

during a session, you will be required to confirm 

disconnect. 

Save Window Size & Position, saves the size and position 

of the emulation window. The next time you open 

PowerTerm Pro, the window appears with the desired 

size at the set position. 

Inactivity Timeout, specifies the time limit for keyboard 

inactivity, after which PowerTerm Pro shuts down. 

On Session Exit Auto Reconnect, re-establishes communication if the line 

was disconnected. 

Auto Exit PowerTerm Pro, closes PowerTerm Pro 

altogether on disconnect. 
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Security Settings Dialogs 

SSL Security 

In the SSL Security Setup dialog you specify your SSL security behavior. 

You may select to accept only certificates that exist in the certificates 

path or any incoming certificate. You can also specify if you want to 

display unknown certificates at connection time and whether you want to 

save them. 

SSH Security 

In the SSH Security dialog you can specify what type of SSH properties 

you require. 
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3. STARTING AND STOPPING 

SESSIONS 

When PowerTerm Pro is used for the first time, the PowerTerm Pro 

window is automatically displayed together with the Connect dialog. After 

the connection parameters have been defined, the Connect dialog will be 

displayed according to your selected options. 

You can determine PowerTerm Pro behavior and automate processes in 

the Preferences property pages. These remain active until you change 

them. For example, if you select to connect automatically at PowerTerm 

Pro startup, you will always be connected when you open PowerTerm Pro. 

Other behaviors you can customize are for example auto-reconnect and 

keyboard inactivity time limit. 

PowerTerm Pro opens with the default terminal setup file. You can also 

open PowerTerm Pro using a customized setup file, or a script file. 

Once you have defined terminal and communication parameters, you can 

then connect to a host. For more information on connections, see chapter 

Defining Connections. 

The communication mode appears beside the application name on the 

PowerTerm Pro window title bar. When communication ends, the mode 

name disappears from view. 

When working with more than one host, PowerTerm Pro enables you to 

connect to a host using customized PSL scripts. You need to define a 

different script with the name of each host. This option provides you with 

a Windows shortcut to a host. For more information about scripts, see 

chapter Scripts. 

PowerTerm Pro also provides the option to modify connection parameters 

for COM type communications. This option is only available once you are 

connected to a host. 

 To start PowerTerm Pro: 

1. Click the Start button in the Task bar. 

2. Select Programs | Ericom Software | PowerTerm Pro | PowerTerm 

Pro. The application is launched. 

 To define preferences: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. The Preferences property page is 

displayed. 

3. Select the parameters that you require. 
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Starting PowerTerm Pro Using a Setup File 

PowerTerm Pro can be started using a default or customized setup file. A 

setup file contains both communication session parameters and terminal 

setup parameters. It is in text format and can be edited using a text 

editor. 

The Default Setup file, called ptdef.pts, is used with single host 

connections. When you open PowerTerm Pro, it automatically uses this 

file to initiate terminal setup and connection parameters. 

A customized setup file is used with multiple host connections and when 

you want to start PowerTerm Pro with predefined communication and 

terminal setup parameters for a specific connection. This can be done by 

using a command or creating a Windows shortcut. Before you create a 

shortcut to a setup file, you first need to create and save the setup file in 

PowerTerm Pro. For more information about creating and customize setup 

files, see chapter Defining Connections. 

 To start PowerTerm Pro with a customized setup file: 

Double-click the PowerTerm Pro shortcut icon on your desktop or access 

it from the Start menu. You session starts automatically with the 

predefined parameters. 

 To use a setup file during PowerTerm Pro session: 

A terminal setup file can also be opened during a PowerTerm Pro session 

to run a session using predefined terminal setup and communication 

parameters. There are two options to use a setup file: 

Select File | Open Terminal Setup. The Open File dialog appears 

in which you can select a setup file. 

Select Communication | Connect. The Connect dialog appears in 

which you can specify the name of the setup file to be run 

before communication is established. 

Starting PowerTerm Pro Using a Script 

You can also launch PowerTerm Pro and run a script immediately upon 

launching. Scripts are created with PowerTerm Pro Script Language (PSL) 

and enable you to automate tasks. For example you can use a script to 

automatically connect to a specific host. For more information about 

scripts, see chapter Scripts. 

Starting PowerTerm Pro with Auto Connect 

The Auto Connect option enables you to automatically connect to a 

specific terminal using the parameters in the default setup file. 
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 To access the Auto Connect option: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Preferences tab. The Preferences Property page is 

displayed. 

3. Select Auto Connect. 

4. Click OK. 

Starting a New PowerTerm Pro Session 

PowerTerm Pro enables you to run two or more sessions concurrently by 

opening a new instance of the PowerTerm Pro window. Each session is 

identified by a letter (starting with A), which appears in the session 

window title bar. A session is assigned the first available letter. For 

example, if A, B and D are opened the next session opened is assigned C. 

 To open a new instance of the PowerTerm Pro window: 

 Select File | New Terminal Window. A new instance of the 

PowerTerm Pro window opens. 

 To toggle between open sessions: 

 Press <Ctrl>+<Spacebar>. 

 To switch to a specific session: 

You can either: 

 Press <Shift>+<Ctrl>+<X>, where X is the session letter. For 

example, if you want to work in session C, you would press 

<Shift>+<Ctrl>+<C>. 

 Click the desired session's icon in the Toolbar. 

 Select Sessions | the desired session. 

Ending a PowerTerm Pro Session 

You need to end the session(s) before exiting the PowerTerm Pro 

application. There are a few options to end a session: 

Automatic closing - PowerTerm Pro enables you to close 

PowerTerm Pro automatically when you close a session. If you 

have modified terminal parameters during a session, a 

message displays asking if you want to save the setup file 

before closing. 

User-initiated closing – Manually closing a session at any time. 

User-initiated fast exit – Sometimes you require a fast exit 

while communication is in progress. PowerTerm Pro then 
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reacts according to the parameters selected in the Preferences 

property page in the Terminal Setup dialog. 

You also have the options such as to require a confirmation when closing 

PowerTerm Pro during a session and to immediately re-connect again, 

automatically or manually (for non-IBM emulations only). 

 To manually close a session: 

Select Communication | Disconnect. 

 To exit PowerTerm Pro: 

1. Select File | Exit. If you have changed the terminal settings, 

PowerTerm Pro displays a warning message asking if you want 

to update the terminal settings file. The message will point to 

the name of the setup file currently loaded. 

2. Click OK to update the file, or NO to cancel the latest changes 

and restore the original settings of the current setup file. 

 To fast exit the current session: 

Press <Alt>+<F4> on the keyboard. 

 To confirm disconnect: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab.  

3. Select Confirm Disconnect Session. 

4. Click OK. 

 To define parameters for automatic closing PowerTerm Pro 

when disconnecting a session: 

Close PowerTerm Pro altogether on disconnect. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Select Auto Exit PowerTerm Pro in the On session exit section. 

4. Click OK. 

 To manually reconnect to a PowerTerm Pro session after exiting 

the current session: 

PowerTerm Pro displays the following message at session termination 

when Auto ReConnect and Auto Exit PowerTerm Pro in the Preferences tab 

are cleared: 
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"Session Closed (0) 

Hit ENTER to Restart Session" 

where the exit code (in this example '0') may have one of the following 

values: 

Zero (0) Communication ended 

successfully. 

Any number (other than 0) Communication aborted. The exit 

code points to the error that 

caused the problem. 

Press Enter on the keyboard.  

 To automatically reconnect a PowerTerm Pro session after 

exiting the current session: 

Re-establish communication if the line was disconnected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Select Auto Reconnect in the On Session Exit section. 

4. Click OK. 

 To specify keyboard inactivity timeout: 

Specify the time limit for keyboard inactivity, after which PowerTerm Pro 

shuts down. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Preferences tab. 

3. Enter the amount of minutes for Inactivity Timeout. 

4. Click OK. 
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4. DEFINING EMULATIONS 

PowerTerm Pro enables you to define the terminal settings for connecting 

to a host. Once you have defined terminal settings, you can save them as 

a setup file. This file can be activated at startup or opened manually 

during a PowerTerm Pro session. You first have to select an emulation 

type and then define the other settings. 

The Emulation property page displays the emulation terminal types 

available with your version of PowerTerm Pro. The emulation type that 

you select changes the tabs (property pages) displayed in the Terminal 

Setup dialog. Some emulation types also change the look of the 

PowerTerm Pro desktop. For example, for IBM 3270 and 5250 terminal 

types the work area is black and the toolbar contains fewer icons. 

The General property page enables you to define parameters for the 

selected emulation type, such as: 

 The ID returned by the emulation program to the host. 

 Communication and keyboard character sets for both 7-bit and 8-

bit data. 

 The behavior of the <Enter> key. 

 Whether applications on the host system can override your user-

defined keys (UDKs). 

 Determines the effects of the numeric keypad on your keyboard. 

(VT emulations only.) 

 The selected host application will usually determine the default option. 

 To define emulation parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Emulation tab. The Emulation property page is 

displayed. 

3. Select the terminal type that you require from the list of 

supported emulations. 

4. Select the General tab. The General property page is 

displayed. 

5. Select the emulation parameters you require. 

6. Click OK. 
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General parameters 

 To define host's ID response: 

This option is disabled when you are connected to a host. 

In the General tab, select Terminal ID from the dropdown list. 

 To specify type of Cursor coupling: 

In the General tab, select Vertical to move the cursor past the top or 

bottom border of the user window, or Page to move the cursor to a new 

page. 

Non-IBM specific parameters 

 To define communication and keyboard character set: 

The available character sets change according to emulation type selected. 

In the General tab, select the NRC/UPS set required from the dropdown 

list. 

 To prevent the host to override your function keys: 

In the General tab, select User Defined Keys Locked. 

 To set the terminal to be online/offline: 

In the General tab, select or clear Online. 

 To define the Enter key behavior: 

In the General tab, select New Line. 

 To show a status line: 

Specify if you want your session's or the host's status line. 

In the General tab, select Indicator or Host Writable. 

IBM specific parameters 

 To define scaled/unscaled screen: 

In the General tab, select or clear Unscaled Screen.  

 To display host response time: 

In the General tab, select Show Response Time. 
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 To define cursor appearance: 

In the General tab, select if you want a Block or Underline display. 

 To define GUI appearance: 

In the General tab, select Power GUI or Show Frame to display a 

"different" look of the work area. 

 To define the code page: 

In the General tab, select Host and PC Code Pages in the dropdown lists. 

 To specify the alternate size: 

In the General tab, select Enable and enter the Rows and Cols (columns) 

sizes. 

VT specific parameters 

 To define the numeric keypad mode: 

The Num Lock key toggles between numeric keys or arrow keys. 

In the General tab, select Numeric and Numlock. 

 To define the application keypad mode: 

The Num Lock key toggles between numeric keys or application keys. 

In the General tab, select Application and Numlock. 

ASCII specific parameters 

 To show the labels line: 

Display a status line at the top and the bottom of the emulation screen. 

In the General tab, select Labels Line. 



 

        Ericom® PowerTerm® Pro           64 of 150         User’s Guide 

5. DEFINING CONNECTIONS 

You can create different connections according to your needs. The 

connection parameters that you define will remain active only for the 

current session, unless you save them. 

The default setup name is the name of the connection. Customized 

settings should be saved with a name other than its current name when 

the PowerTerm Pro session is running. 

You can also delete connections that are no longer in use. 

 To define a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select Session Type and enter required parameters. 

3. Select the Terminal Type and ID. 

4. Select the desired Security to be employed in the connection. 

5. Specify, if necessary, the Script and/or Setup files to be run 

upon connection. 

6. Click Connect. 
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 To specify SSL Security parameters: 

1. Select SSL in the Security Type dropdown list and click Details. 

The SSL Security dialog is displayed: 

7. Select the desired SSL Version and click OK. 

 To specify SSH Security parameters: 

1. Select SSH in the Security Type dropdown list and click Details. 

The SSH Security dialog is displayed: 

2. Select the desired SSH Version. 

3. Specify the SSH properties. 

4. Click OK. 

 

 



 

        Ericom® PowerTerm® Pro           66 of 150         User’s Guide 

 To save a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select Session Type and enter required parameters. 

3. Select the Terminal Type and ID. 

4. Select the desired Security to be employed in the connection. 

5. Specify, if necessary, the Script and/or Setup files to be run 

upon connection. 

6. Click Add Session button.  

7. Enter a Session Name and click Apply. The connection is 

displayed in the Sessions List. 

 To use an existing connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click Connect. 

 To modify connection parameters: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Make desired changes in the parameters. 

4. Click Apply. 

 To rename a session: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Double-click on the session name to rename.  

4. Enter a new Session Name and click Apply 

 To delete a connection: 

1. Select Communication | Connect. The Connect dialog appears. 

2. Select the desired session from the Sessions List. 

3. Click the Delete Session button. A confirmation notification is 

displayed. 

4. Click Yes. The connection is deleted. 

5. Manipulating the Desktop and Selecting Text 

PowerTerm Pro enables you to customize the PowerTerm Pro window by 

displaying or hiding desktop components and changing the display colors 
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for different text attributes. The color attributes change according to the 

emulation type you have selected. 

This chapter also presents specific text selection techniques that you may 

find useful in different emulations. 

Show/Hide Desktop Components 

Most components are displayed or hidden according to your selection in 

the Options menu. 

 To show/hide the Menu bar: 

1. Select View | Menu. This conceals the Menu bar. 

2. Right-click on the title bar and choose Restore Menu. The Menu 

bar is shown again. 

Or, 

Map a Soft button with the following PSL command: 

menu restore 

 To show/hide the Soft buttons: 

Select View | Function Buttons. Select again to redisplay the 

Soft buttons bar. 

 To show/hide the Status bar: 

Select View | Status Bar. Select again to redisplay the Status 

bar. 

 To show/hide the Power Pad: 

Select Options | Show Power Pad. The menu option becomes 

Hide Power Pad. 

Select again to hide the Power Pad. 

 To show/hide the History Scroll bar: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select or clear History Scroll Bar in the General section. 

4. Click OK. 

Changing the Desktop Display 

You can customize your desktop display in numerous ways, for example 
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change colors of background and/or text, change the cursor display, 

change the work area dimensions, as well as select fonts and GUI 

language. 

 To change the GUI language: 

In the Terminal menu, select the desired language. 

Setting Fonts 

PowerTerm Pro enables you to use standard system fonts or select 

special PowerTerm Pro fonts to be displayed in the PowerTerm Pro 

window. 

System fonts are standard general-purpose fonts, which 

different attributes can be set. 

PowerTerm Pro fonts are scaleable fonts, automatically 

calculated according to the screen size of the host application 

and whether the Unscaled screen option is selected or not. 

 To work with PowerTerm Pro fonts: 

Select Terminal | PowerTerm Pro Fonts. The PowerTerm Pro window will 

now display PowerTerm Pro fonts. 

 To work with system fonts: 

1. Select Terminal | System Fonts. The Font dialog appears. 

2. Select the font, style, and size as you desire. 

3. Click OK. The PowerTerm Pro window will now display the 

selected system font. 

 To work with VT soft fonts: 

For VT emulations only. 

The fonts will be loaded from the host application. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Enable soft fonts. 

 To lock font size: 

Characters appearing in the work area are scaled and their size will 

change proportionally when changing the desktop size. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General 

tab for IBM emulations. 
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3. Select Unscaled Screen to lock the font size. 

 To wrap words at the end of a line: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Autowrap Characters. 

Setting Color 

 To change the display color of the PowerTerm Pro window: 

The color for the Normal attribute determines the color of the entire work 

area. The box above the Select Attribute parameter shows the result of 

your selections. The Select Attribute of the entire screen is generally 

Normal for non-IBM emulations. 

1. Select Terminal | Color. The Color property page is displayed. 

2. Select the attribute for which you want to define foreground and 

background colors. Notice that the attributes change according 

to the emulation type you selected previously. 

In the Text area, select the color that you want to apply to the 

text (foreground) of the display. 

In the Background area, select the color that you want to apply 

to the background of the text. The preview box above the 

Select Attribute parameter shows the result of your selections. 

3. Click OK. 

 To reverse display colors: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select Reverse Display Colors. 

 To specify ANSI/Attribute colors: 

For non-IBM emulations only. 

Select Terminal | Colors. The Colors property page is displayed. 

1. Select your preference in the Default Colors drop down list. 

Setting work area 

 To specify dimensions of screen: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 
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2. Click the Display tab. The Display property page is displayed. 

3. Select if you want 80 or 132 Columns or enter your own number 

of columns in Other. 

4. Select how many Lines per screen you want, from the 

dropdown list. 

6. You can also specify if you want to Limit the font size. 

 To change the appearance of the PowerTerm Pro window: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General 

tab for IBM emulations. 

3. Select Power GUI or Show Frame as desired.  

 To specify pace at which data is displayed: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab. The Display property page is displayed. 

3. Select if you want Smooth or Jump scrolling. 

4. Select Jump Scroll Speed from the dropdown list. 

 To set tabs in the work area: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Tabs tab. The Tabs property page is displayed. 

3. Click in the ruler where you want to set a tab. A 'T' will appear. 

4. Click the 'T' to clear it. 

5. You can also specify a certain interval between the tabs by 

entering a number and then click Set Every. 

 To set cursor coupling: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Vertical and/or Page for when the cursor moves past the 

top or bottom border of the user window or to a new page 

respectively. 

 To display a cursor ruler: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General 
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tab for IBM emulations. 

3. Select Visible to display the cursor ruler. 

4. Select Crosshair/Horizontal/Vertical appearance of the cursor 

ruler. 

 To change cursor appearance: 

For IBM 3270 and 5250 display emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Display tab for non-IBM emulations and the General 

tab for IBM emulations. 

3. Select in Cursor the desired appearance (Block or Underline). 

4. Select Ins Change to enable toggling the cursor between 

underline and block appearance. This will impact the behavior 

of the Ins (Insert) button on your keyboard. 

 To display the status line in the emulation window: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select desired option in the Status Line dropdown list. 

 To display the Labels line in the emulation window: 

For ASCII emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Labels Line. 

 To show host response time: 

For IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the General tab. The General property page is displayed. 

3. Select Show Response Time. 

 To disable/enable underlined data: 

If data is transmitted with the underline attribute, you can disable the 

underline by clearing this parameter. 

Select Terminal | Colors. The Colors property page is displayed. 

1. Select/Clear Enable Underline as desired. 
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 To disable/enable blinking data: 

You can choose whether to enable blinking of data, which was received 

from the host with the blinking attribute. 

Select Terminal | Colors. The Colors property page is displayed. 

1. Select/Clear Enable Blink as desired. 

 To set column separator: 

For IBM 5250 emulations only. 

1. Select Terminal | Colors. The Colors property page is 

displayed. 

2. Select Column Separator. 

Selecting Text 

General selection techniques 

 To select a word: 

In the work area, just click a word to select it. 

<Ctrl> + clicking the word will select the word and any 

punctuation marks or other symbols, up to the first space that 

follows them. 

 If the Automatic Copy option in the Edit menu is active (default), 

selecting text also copies the selection to the clipboard. 

 To select full lines: 

Point to a line, hold down the <Shift> key on the keyboard and drag the 

mouse to the last line you want to include in the selection. 

 To select a string: 

1. Point to the first character that you want to include in the 

selection. 

2. Drag the mouse to the last character that you want to include 

in the selection and release the mouse button. 

 To select the entire screen: 

Select Edit | Select Screen. 
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VT emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

Point to one corner of the block, hold down the <Ctrl> key on 

the keyboard and drag the mouse to the opposite corner of 

the block you want to include in the selection. 

 To select a menu entry: 

Double-clicking on a word sends that word to the host followed by an 

<Enter> signal. Use this feature to select a menu entry. For example, if 

the emulation screen displays the menu of an application residing on the 

host, click a menu entry to activate the program that the menu entry 

represents. 

IBM emulations' specific techniques 

 To select a block: 

A block is any rectangular section or the work area. 

Point to one corner of the block and drag the mouse to the 

opposite corner of the block you want to include in the 

selection. 

    To map arrow keys that enable Shift + arrow key combination to 

perform text selection:  

1. Run psl command 'set select-key-highlight on'. 

2. Click on the Shift key in the PC keyboard. 

3. Click on the Shift key in the 3270 keyboard. The SelUp, SelDN, 

SelLf and SelRt keys are visible. 

4. Drag the SelUp, SelDN, SelLf and SelRt keys on the 3270/5250 

keyboard to their respective arrow key positions on the PC 

keyboard as shown below:  
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 To activate light pen support: 

For IBM 3270 emulations. 

In certain fields double-click on the screen is equivalent to touching the 

screen with a light pen. 
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6. KEYBOARD SETTINGS 

PowerTerm Pro enables you to map PC keys to host keys in order to 

emulate the host terminal keyboard. The keyboard mapping definitions 

are stored in a file with the same name as the current terminal setup file, 

with the extension .ptk. For example, the default keyboard mapping 

definitions are stored in a file called ptdef.ptk. 

You can also modify your keyboard to behave in certain ways such as 

having the Backspace key send either backspace or delete, or letting the 

Numpad send a comma. 

Mapping Keys 

The Keyboard Mapping dialog is presented in three colors: 

Gray, is a virtual (terminal) key 

White, is an OS character 

Yellow, is an OS dead character 

 To view the keyboard mapping: 

1. Select Options | Keyboard Map. The Keyboard Mapping dialog 

appears. 
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2. Slide the mouse pointer over the different keys. The bottom 

line of the dialog shows you the corresponding PC and terminal 

keys. For example, if you point to the "t" key of the VT 

keyboard, you see that the corresponding PC key is "T". 

 To map a PC key: 

Drag a key from the upper terminal keyboard to a PC key on 

the lower keyboard. 

Click the <Shift> or <Ctrl> keys on the terminal keyboard to 

display additional key functions. For example, if you click the 

<Shift> key, the alphabet keys on the terminal keyboard are 

displayed in upper case. You can then map (drag) these keys 

to your PC keyboard keys. 

 To assign a script command to a PC key: 

1. Right-click a key on the PC keyboard that you want to assign a 

command and select Enter Script Commands. The PC Button 

dialog appears. 

2. Enter the desired script command and click OK. The PC key has 

now been assigned a script command. 

 To map combinations of keys that include Alt, Ctrl, and Shift: 

Click the <Alt>, <Ctrl> or <Shift> key (or any combination of 

them) on your PC keyboard. Then map keys by following the 

procedure described previously. 

Click the required <Alt>, <Ctrl> or <Shift> key (or any 

combination of them) to view the mapped keys. 

 To cancel a key definition: 

Drag the PC key definition that you want to cancel to . This restores 

the default function of the PC key. 

 To replace a PC key with another PC key: 

PowerTerm Pro enables you to move the functionality of a mapped PC 

key to another PC key. For example, you can drag the F6 key on the PC 

keyboard to the spacebar on the PC keyboard to give it F6 functionality. 

Drag the desired PC key onto the PC key that it will replace. 

The functionality of the PC key has been replaced. 

Drag the original key back to its initial position to restore the 

values. 
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 To copy a PC key to another PC key: 

PowerTerm Pro enables you to copy the functionality of one PC key to 

another PC key. 

1. Select the PC key whose function you want to copy to the 

required PC key and right-click Copy. 

7. Select the PC key to where you want to copy the function and 

right-click Paste. Both keys now have the same functionality. 

 To restore the default keyboard mapping of all mapped keys: 

Click Defaults in the Keyboard Mapping dialog. 

Saving and Opening Keyboard Mapping 
Settings 

PowerTerm Pro enables you to save keyboard-mapping settings 

separately and open them at a later date.  

 To save keyboard mapping settings: 

1. Select File | Keyboard File > Save. The Save Keyboard File dialog 

is displayed. 

2. Enter a File Name. 

3. Click Save. 

 To open a predefined keyboard mapping settings: 

1. Select File | Keyboard File > Open. The Open Keyboard File dialog 

is displayed. 

2. Select the required keyboard settings from the list. 

3. Click Open. Parameters defined in the selected keyboard 

settings are now applied to the current session. 

Keyboard Behavior 

You can customize your keyboard. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is 

displayed. 

3. Select the behaviors you desire and click OK. 

 To lock alphabet keys in uppercase: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 
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2. Click the Keyboard tab. The Keyboard property page is 

displayed. 

3. Select Caps (Unix). 

 To lock alphabet and numeric keys in shift setting: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is 

displayed. 

3. Select Shift. 

 To reverse the Caps Lock: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is 

displayed. 

3. Select Reverse (Win). Pressing Shift on your keyboard reverses 

the caps operation. 

 To keep Caps Lock mode On: 

You can turn Caps Lock Off in a different application and keep it On in 

PowerTerm Pro. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Click the Keyboard tab. The Keyboard property page is 

displayed. 

3. Select Always On. 

 To set the Backspace key: 

The Backspace key can either send Delete or an actual Backspace. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select or clear Backspace Key Sends Delete as you desire and 

click OK. 

 To automatically repeat a character: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Auto Repeat and click OK. The character will display 

repeatedly when you continuously press its key on the 

keyboard. 

 To emit a sound when certain actions are taken: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 
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2. Click the Keyboard tab. The Keyboard property page is 

displayed. 

3. Click Sound > Key Click to emit a click sound when you press 

a key on the keyboard. 

4. Select Margin Bell to emit a bell tone when the cursor reaches 

the right margin. 

5. Select Warning Bell to emit a bell tone when receiving the "bell" 

(ASCII 7) character. 

 To set the effects of the numeric keypad: 

For VT emulations only. 

1. Select Terminal | Setup and click the General tab. 

2. Select Numeric if you want the keypad to insert numbers. 

3. Select Application if you want to generate control sequences. 

4. Select or clear Numlock to set the NumLock key behavior:  

Cleared, the NumLock behaves as a regular emulation key. It 

will not change the NumLock keyboard status. 

Selected, the NumLock will toggle between function states, 

enabling either numeric keys or arrow keys. 

5. Click OK. 

 To set the numpad decimal: 

The numeric pad's decimal key can send either a decimal or a comma. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select or clear Numpad Decimal Sends Comma as you desire and 

click OK. 

 To use emulator Alt key: 

Let the <Alt> key perform the terminal operation even if Windows OS 

has an operation mapped to the same key. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Use Emulator Alt Keys and click OK. 

 To display keyboard input: 

Display the keyboard input even if the host system does not echo your 

input. The input will not be displayed if this option is cleared unless the 

host system echoes the characters. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Local Echo and click OK. 
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 To set an LK450 Digital keyboard: 

For non-IBM emulations only. 

Change your keyboard to work in Digital VT keyboard mode. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Use VT Keyboard Mode and click OK. 

 To display an answerback message: 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Specify your desired Answerback Message. 

3. Clear to delete the message. 

4. Conceal to hiding the message without erasing it. 

5. Select Auto Answerback to let the terminal automatically send 

the message to the host system. 

6. Click OK. 

 To lock numeric fields: 

For IBM 3270 emulations only. 

Lock the keyboard to avoid entering non-numeric data. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Lock Numeric Fields and click OK. 

 To unlock numeric fields: 

For IBM 3270 emulations only. 

You can enter non-numeric data in numeric fields in two ways. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Lock Numeric Fields twice so it becomes selected but 

grayed out. Non-numeric data can be typed in the field only if 

<Shift> is pressed at the same time. 

3. Clear Lock Numeric Fields. All data can be typed in the field. 

 To type ahead: 

For IBM emulations only. 

Continue to type data before the host responds. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Typeahead and click OK. 
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 To set automatic reset: 

Generate a reset key sequence prior to advance to the next field. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Automatic Reset Key and click OK. 

 To set SNA system wait: 

For IBM 3270 emulations only. 

1. Select Terminal | Setup and click the Keyboard tab. 

2. Select Non SNA System Wait and click OK. 
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7. SOFT BUTTONS AND POWER PAD 

Along the bottom of the PowerTerm Pro window are twelve 

programmable Soft buttons, by default named from F1 to F12. These can 

be renamed and programmed to execute customized scripts or to send 

individual commands to the host. For example, clicking the F1 Soft button 

is equivalent to sending F1 to the host. 

Soft buttons settings are saved automatically in the terminal setup file. 

The Power Pad is a floating keypad that contains buttons, which can be 

programmed to execute customized PSL scripts. You can also change 

their names and adjust the number of buttons displayed in the Power 

Pad. Power Pad buttons are named by default F1, F2, F3 and so on, with 

a few default function names, such as Clear, Enter, and Insert. For 

example, clicking on the F1 button is equivalent to sending F1 to the 

host. 

Power Pad settings are saved in separate files with the .pad extension. 

 To program Soft buttons: 

1. Right-click the Soft button that you want to program. The 

Function Button dialog is displayed: 

2. Enter the Function Description (the new name that will appear 

on the button). 

3. Enter a Script Command, or script commands separated by 

semicolons. 

4. Click OK. The Soft button is now displayed with its new name. 

Clicking on it will execute the newly defined script command.  

 To program the Power Pad: 

1. Select Options | Show Power Pad or click . The Power Pad is 

displayed. 

 



 

        Ericom® PowerTerm® Pro           83 of 150         User’s Guide 

2. Right-click the Power Pad button that you want to program. 

The Power Pad Button dialog is displayed: 

3. Enter Button Description (the new name that will appear on 

the Power Pad button). 

4. Enter a Script Command, or script commands separated by 

semicolons. 

5. Click OK. The Power pad button is now displayed with its new 

name. Clicking on it will execute the newly defined script 

command.  

 To adjust the number of buttons in the Power Pad: 

You can display a maximum of 10 rows and 10 columns in the Power Pad. 

The default number of buttons is 9 rows and 4 columns. 

1. Select Options | Power Pad Setup. The Power Pad Setup dialog is 

displayed: 

6. Click the dropdown list to select the number of rows and 

columns that you want the Power Pad to contain. 

7. Click OK. The Power Pad is displayed with the specified 

number of rows and columns.  

 To save your Power Pad settings: 

2. Select File | Power Pad File > Save. The Save Power Pad File 

dialog is displayed. 
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3. Enter a File name and click Save. 

 To open predefined Power Pad settings: 

1. Select File | Power Pad File > Open. The Open Power Pad File 

dialog is displayed. 

2. Select the required Power Pad file and click Open. Parameters 

defined in the selected Power Pad setup are now applied to the 

current session. 
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8. PRINTING 

Printer emulation is the printing of data from a host to personal printers 

connected to personal computers (PC). Host applications generate print 

jobs that can be printed on host attached printers or printers attached to 

PCs. The actual location of the printer is transparent to the host 

application. Print emulation is the receiving of data in host format or 

languages and converting it to printer format and languages. 

PowerTerm Pro InterConnect enables you to define print parameters in 

order to print the terminal screen or data transferred from the host 

application. 

PowerTerm Pro InterConnect supports three methods of printing host 

information to local or network-accessible printer resources: 

 Screen printing, allows printing what is on the display using ‘print 

screen’ features of the client operating system. You can direct the 

printer output to a printer attached to the client computer or to a 

network-accessible resource. 

 Client-redirected printing, delivers a host printer data stream to 

the appropriate emulation application running on a client 

computer. The client software converts the data stream into data 

that can be output to a locally attached or network-accessible 

printer resource. 

 Server-based redirected printing, uses a server process to 

convert SNA host printer data streams into data that can be 

redirected to a locally attached or network-accessible printer 

resource defined with the Windows NT Server Printer Manager. 

In most cases, you do not have to modify the standard printer stream 

before sending it to a defined printer. If you need to change, the Printer 

property page and Advanced Printing setup dialogs enables you to define 

printing parameters. 

Printing can be done in either Text or Graphic mode. For IBM 5250 

printing emulations there is also the option to enable Host Transform 

printing. 

Advanced Printing 

More specifically in regards to Advanced Printing setup, if the user wants 

to format line data in a format other than that which was originally 

generated by the application, additional information must be provided in 

the page format. This additional information defines the following: 

Locations and lengths of fields in the input record 

Placement, direction, and font for each field, as it is mapped 

into page format 

Suppression of fields, which is usually specified if multiple-
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page copies are printed with field suppressions on selected 

copies. 

The two different modes, Text and Graphic, impact which fields are 

functional in the Advanced Printing Setup dialog: 

Text mode is designated in the Printer property page by setting 

the two data conversion combo boxes (Print Screen or Slave 

Printer) to non-graphic values (Host/None/UTF-8). Either the 

host instructs the printer or you specify the desired print 

escape sequences in a .ped file. 

Graphics mode is graphic printing. It is designated in the 

Printer property page by setting the two data conversion 

combo boxes (Print Screen or Slave Printer) to Graphics. 

General Printing Operations 

 To define a printer via the Windows Print Manager: 

1. Select File | Print Setup. The Print Setup dialog appears with a 

set of printing parameters. The displayed parameters change 

according to the printer you select. For details, consult your 

printer documentation. 

 Specify desired printer parameters and click OK 

 To print accumulated data displayed in the work area: 

2. Select File | Start Auto Print. The Start Auto Print command 

starts accumulating incoming data while it is displayed on the 

screen, and the menu option changes to Stop Printing. 

3. Select File | Stop Printing. The Stop Printing command prints 

all the data accumulated in the printing buffer of the slave 

printer, or in the auto print buffer. If data was buffered with a 

printing request and communication failed before the data 

was sent to the slave printer, select this command to print the 

accumulated data. 

 To define printing parameters: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. The Printer property page is displayed. 

3. Select the parameters that you require. 
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  To select a specific device or file as the printing output channel: 

 When Graphics is selected for Print Screen Data Conversion/Slave Printer 

Data Conversion, the Print Manager is automatically used as the 

printing output channel, regardless of the Print Device that has been 

selected. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and from the Print Device dropdown list 

select Device or File. 

3. Enter your print communication port or file in the Device Name 

field and click OK. 

 To configure the OS default printer as the printing output 

channel: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and from the Print Device dropdown list 

select Print Manager. 

 To add a form feed after each printing job: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Use Form Feed. 

 To define the form type of the printer: 

PowerTerm Pro provides three types of form type: 

 

Autocut Single-cut sheets are automatically fed into the printer. 

Most printers require a sheet feed attachment. 

Cont Continuous forms are used by the printers that have a 

tractor feed attachment on the device. 

Cut Single-cut sheets are manually fed into the printer. 

 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advanced Printing. The Advanced Printer Setup dialog 

appears. 

4. Select the desired Form Feed. 
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 To add a line feed after each carriage return: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select LF->CRLF. 

 To convert line graphics to text: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Print Line Graphics as Text. 

 To specify the character or symbol to separate one printing job 

from another: 

For non-IBM emulations only. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Slave Printer Job Delimiter. 

 To delay print closing: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab, and select Delay for Print Closing. 

 To change page orientation: 

Default orientation depends on your printer's settings. The options are: 

Ignore, Portrait and Landscape. 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer property page. 

3. Click Advanced Printing. The Advanced Printer Setup dialog 

appears. 

4. Select desired page Orientation in the dropdown list. 

 To set an LU/Device name: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. From the Emulation tab, select either IBM 3270 or 5250 

Display, and click OK. 

3. Select Communication | Connect. The Connect dialog appears. 

4. Select your Session Type and enter the IBM Host Name. 

5. In the LU/Device Name field, specify the device name for the 

emulation session. The maximum length of the assigned LU 

name is 8 characters, while that of Device name is 10 

characters. 

When using multiple sessions, enter a plus sign (+) after the 
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name (e.g. John+) and each session will automatically be 

assigned a new name (John1, John2, etc.). 

 

LU Rules 

"lu-rule" is any valid data that can be put in the lu/device-name field such 

as DEV*, DEV+++, DEV3-, etc. These rules can be applied for multiple 

hosts as follows: 

host1(lu-rule1a,lu-rule1b,...),host2(lu-rule2a,lu-rule2b,)... 

 Maximum of 10 lu-rules for each host. 

Automatic Name Generation according to User’s Rules 

TN3270 LU Name and TN5250 Session Device Name Options 

Device Name 

 

Entered  Assigned 

DEV- DEV0 to DEV9  

DEV--  DEV00 to DEV99 And so on … 

 

DEV+ DEV1 to DEV9 

DEV++ DEV01 to DEV99 And so on … 

Session Pool device name (3270 and 5250) 

DEV* DEV1 to DEV9 

DEV** DEV01 to DEV99 And so on … 

DEV-3  DEV0 to DEV3 DEV-30 

DEV-30  DEV00 to DEV30  And so on … 

DEV+3 or DEV*3 DEV1 to DEV3 

DEV+30or DEV*30 DEV01 to DEV30  And so on … 

    

The difference in behavior between specific LU/Device naming, specific 

LU/Device naming by Session ID and pool LU/device naming can be 

demonstrated in the following examples:  

Specific LU/Device Naming 



 

        Ericom® PowerTerm® Pro           90 of 150         User’s Guide 

A specific name like SALES1 is entered. If it is not available, the 

connection attempt fails. 

Specific LU/Device Naming by Session ID 

DEV+ (a session ID) was entered as the device name when session E  (a 

local non-unique identifier) was opened. It will try to connect only as 

DEV5, and will fail if that LU/device name is not available since each 

session has its own unique name. 

DEV- (a session ID) was entered as the LU/device name when session E 

(a local non-unique identifier) was opened. It will try to connect only as 

DEV4, and will fail if that LU/device name is not available since each 

session has its own unique name. 

Pool LU/Device Naming 

DEV** was entered as the LU/device name when session E (or any other 

session) was opened. It will try to find an available LU/device name 

between DEV01 and DEV99, starting with DEV01, then DEV02, etc. Only 

if none of these LU/device names are available will it fail. 

IBM 5250 Printer Session Data Conversion 

Graphic Mode 

A graphic is a pictorial representation of data which is processed 

differently than text by the emulation.  

    To achieve the best fit for the page: 

1. Set Slave Printer Data Conversion to None. 

2. Set CPI to Auto/Auto Printer. 

Note: Whenever the CPI or LPI field is set to Auto/Auto 

Printer you must specify the desired page type for text 

printing. 

3. Select desired Page Type for Text Printing. 

    To use the host's CPI value: 

For 5250 Printer emulations only. 

1. Set Slave Printer Data Conversion to Graphics. 

2. Select Use Host Value in the CPI field. 

3. Verify that Enable AS/400 Host Print Transform is not selected. 

    To set the margins: 

Printout margins are the space between the edge of the printout page 

and the border of the printing. Modifying the top and left margins will 

determine the position at which printing will begin. 

You can minimize/maximize the margins or alternatively shift the 

print margins (i.e. 30 in the right margin and -30 in the left margin). 
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1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Select Graphics for Slave Data Printer Conversion. 

4. Click the Advanced Printing button. The Advanced Printer Setup 

dialog box is displayed. 

5. From the Printer/Type Model drop down list, select the desired 

printer. 

6. Note If your manufacturer Printer Type and Model are not 

listed, then choose one that is compatible.  

7. Define the Margins. For example, to shift the margin 1 cm type 

in 100. 

Note When Auto/Auto (Printer Sizes) is selected (the default 

printer values are used) for CPI, then the right margin field is 

enabled. When either of these values is selected for LPI, the 

bottom margin field is activated. 

Text Mode 

Text mode is designated in the Printer Property Page by setting the two 

data conversion combo boxes (Print Screen or Slave Printer) to non-

graphic values (Host/None/UTF-8). 

In text mode, a printer selection is useful since PowerTerm Pro requires 

the printer specific escape sequences to instruct it how to format the 

document to be printed. 

Page orientation is relevant to non-graphic mode, as long as you select 

the correct printer in Advanced Printer Setup. 

Recommended for dot matrix printers. 

Host Print Transform 

The Host Print Transform feature allows the SCS-to-ASCII data stream 

conversion to take place on the host server instead of by PowerTerm Pro 

InterConnect. 

 The Printer settings/properties impact the data stream prior to 

reaching the output destination. Therefore any changes following this 

made in Windows will have no effect on the PowerTerm Pro printer 

settings. 

When Host Print Transform is enabled, SCS data is transformed to ASCII 

data and passed through PowerTerm Pro to the specified ASCII printer. If 

the data stream is ASCII, the data is sent directly to the printer, and not 

converted by PowerTerm Pro. This is relevant when printing to a specific 

printer such as barcode or in an environment which has limited 

memory. Insufficient memory could be due to several factors, for 

example there is no Print Manager installed, the .ped files cannot be 

installed, or you cannot print in Graphic mode. 
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 To set values for IBM 5250 host print transform: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Select a text mode (Host/None/UTF-8) for Slave Data Printer 

Conversion. 

4. Click Advanced Printing. The Advanced Printer Setup dialog 

appears. 

5. Select Enable AS/400 Host Print Transform and select the 

parameters you require. 

  To use the host's CPI value: 

For 5250 Printer emulations only. 

1. Set Slave Printer Data Conversion to None. 

2. Select the correct printer. 

3. Select Use Host Value in the CPI field. 

 Typically AS/400 sends the CPI escapes to the terminal however if you 

selected "Other Printer" then you must create "other.ped" file with all 

the relevant escapes.  

4. Verify that Enable AS/400 Host Print Transform is not 

selected.  

Non-IBM 5250 Printer Session Data 
Conversion 

Graphic Mode 

A graphic is a pictorial representation of data which is processed 

differently than text by the emulation.  

    To achieve the best fit for the page: 

1. Select Terminal | Setup. The Terminal Setup dialog appears. 

2. Select the Printer tab. 

3. Set Slave Printer Data Conversion to Graphics. 

4. Set CPI to Auto. 

Note Selection of Auto is the best fit for the page, while Auto 

(Printer Sizes) is best fit for the page using only the pre-

defined printer font sizes. 

5. Select the desired Page Type for Text Printing. 
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Text Mode 

Text mode is designated in the Printer Property Page by setting the two 

data conversion combo boxes (Print Screen or Slave Printer) to non-

graphics value (Host/None/UTF-8). 

Page orientation is relevant to non-graphic mode, as long as you select 

the correct printer in Advanced Printer Setup. 

Escape Sequences 

An escape sequence is a series of characters used to trigger some sort of 

command state in computers and their attached peripherals. A text editor 

(like VI) can display lines of text in a terminal window by simply writing 

those characters to the window. However, in order to perform such 

functions as moving the cursor, making text brighter, or erasing part (or 

all) of the screen you must send escape sequences: special strings of 

characters meant to control the terminal. A terminal observes each input 

character and, if it is a part of an escape sequence, it interprets that 

character string as a command instead of displaying it as text. 

You can record the necessary escape sequences in a number of ways:  

.prt files  

.ped files  

Via keyboard mapping 

Printer Configuration Files (.prt) 

The Printer Configuration Files (.prt) enables the user to manipulate the 

printer output (for example: bold, italic, underline). Typically you would 

use the escape sequences in the PowerTerm Pro supplied prt file. 

However, there are circumstances that would warrant you referencing 

alternative escape sequences. 

Typical Use 

1. Verify the existence of the .prt file in the folder where 

ptpro.exe resides.  

2. Create a PSL file with the following name: open-printer file 

yourfilename.prt 

Referencing alternative escape sequences 

There are times when the printer will print an unnecessary escape 

sequence. To avoid this situation, the following solution will enable you to 

have the emulation program reference an alternative sequence, thus 

replacing it with a more effective sequence.   

The source.prt and customized prt files be located in the same folder as the 

PowerTerm Pro product executable. 
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1. Edit the source.prt file in the following manner: blank = X1B 

escapesequence (which the emulation should ignore)  

2. Save the file.  

3. Create the file ignore.prt with the following line: blank =  

4. Save the file ignore.prt to the PowerTerm Pro folder.  

5. Create a PSL file with the following line: open-printer file 

ignore.prt  

6. Save the PSL file to the PowerTerm Pro folder.  

7. Edit the PowerTerm Pro InterConnect shortcut by adding the 

newly created PSL file name after the exe (preceded by a 

space).  

8. Double-click the shortcut icon. 

Modifying Printer Settings via the .PED file 

The .ped files are very useful when you want to modify a particular print 

setting: page orientation, LPI (Lines Per Inch) or CPI (Characters Per 

Inch). 

The .ped files are located in C:\Program Files\Ericom 

Software\PowerTerm Pro\printers 

You must insure that the Printer Properties Page parameters are set 

correctly before applying the .ped settings: 

 To Print Screen: 

1. Select Terminal | Setup. The Terminal Setup dialog is 

displayed. 

2. Select the Printer tab. The Printer properties page is displayed. 

3. Set Print Screen Data Conversion to "None". 

 

 To use Slave Printing: 

1. Select Terminal | Setup. The Terminal Setup dialog is 

displayed. 

2. Select the Printer tab. The Printer properties page is displayed. 

3. Set Slave Printer Data Conversion to "None". 

If the value "Graphic" is left in the above fields then OS Print manager takes 

control and decides how to print the job. 
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 To change the default (if necessary): 

1. Open up the desired PED file in a text editor such as Notepad. 

2. Locate the section entitled "[Printer Escapes]". 

3. Add a line starting with "init = ". Note: This will initialize the 

printer for this specific setting which may be overwritten by a 

subsequent modification in the user interface.  

4. Type list of desired escape sequences (separating each one 

with a ";"). 

5. Save the PED file. The new escape sequences will be applied to 

future outputs. 

Troubleshooting Printing Issues 

If you have any difficulties with PowerTerm Pro InterConnect printing, 

refer to the following checklist: 

‘Timeout on printer’ message Select File | Print Setup, and set 

the ‘device’ as ‘Print Manager’ or 

‘Network’. 

Unsuccessful printing to default 

printer 

Employ the use-default-printer PSL 

script. 

Prints end of line text onto the next 

line 

Open Terminal | Setup | Display 

and click the General tab. 

Clear the Autowrap Characters 

check box. 

Click the OK button. 

Click File | Save Terminal Setup 

132 column reports are resulting in 

80 column format. 

Changing CPI as well as print 

columns with no result. 

In the Printer properties page, 

assign the following values: 

Print Screen Data Conversion – 

Graphic 

Slave Printer Data Conversion – 

Graphic 

Delay for Print Closing – 5 

In the Advanced Printing dialog, 

assign the following values: 

CPI – user defined 17, 132 columns 
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LPI – auto 

The user requires 13x11 inches 

paper size for an Oki Microline 

3321 printer. This is for slave 

printing where Print Device is 

defined as File and Device name as 

lp1. 

The print output is only letter size 

(8.5 inches). 

In the Advanced Printing dialog, 

select the printer which is most 

compatible to your printer and set 

CPI and LPI to ‘Auto (paper size)’. 

The user’s printer name does not 

appear in the Print Setup. 

Delete the ptw_prt1.cfg and 

ptw_prt2.cfg files from the 

Windows directory and restart 

PowerTerm Pro. 

Lines are printed on top of each 

other. 

Change the End-of Medium 

parameter CR to CRLF in the pts 

file. 

Cannot open the print setup file. Delete *.prt files in the Working 

directory and *.cfg files in the 

Windows directory. 
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9. SCRIPTS 

PowerTerm Pro enables you to create scripts for automating tasks. For 

example, you can create a script to login to a PowerTerm Pro session, 

execute a file, display a message, etc. Scripts can be run upon startup or 

during a PowerTerm Pro session. They can be written in any standard 

text editor, like Notepad, and are saved with a .psl extension. This 

chapter describes how to create, edit, run, save and activate script in 

PowerTerm Pro. 

The PowerTerm Pro Script Language (PSL) is PowerTerm Pro's own 

programming language. For a full description of the different PSL 

commands, see the "PowerTerm Pro Script Language, Programmer's 

Reference". 

PowerTerm Pro provides the following script options: 

Create a Script, creates a script to run upon startup or at any 

time during a PowerTerm Pro session. 

Edit a Script, edits and modifies an existing script file. 

Record a Script, creates a script by recording all the actions 

that you perform in the PowerTerm Pro window. Actions can 

include selecting a menu option, typing an entry on the 

screen, making selections in a dialog, and so on. 

Run Scripts, runs specific scripts or individual commands, 

upon startup, connection to a host, or during a PowerTerm Pro 

session, to automate specific tasks, you can only run saved 

scripts. 

Activate a Recorded Script, executes a non-saved script from 

the current memory. 

Save a Recorded Script, saves your script to be used at a later 

date. 

Assign Scripts, to the Power Pad and Soft buttons. 

 To create a script file: 

1. Select Script | Edit Script. The Edit Script dialog appears. 

2. Type a name for the new script in the script Name text box. 

3. Click Edit. The PowerTerm Pro Script Editor appears. 

4. Type the script and click Save from the File menu to save your 

new script. The next time you run or edit a script, this new file 

will appear in the Scripts List. 

5. Select File | Exit to exit the editor. 
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 To edit a script file: 

1. Select Script | Edit Script. The Edit Script dialog appears. 

2. Select the required script file and click OK. The PowerTerm 

Pro Script Editor appears. 

3. Edit the script and click Save from the File menu to save your 

changes. 

4. Select File | Exit to exit the editor. 

 To record a script: 

1. Select Script | Start Script Recording or click . Your actions 

start to be recorded and the menu option changes to Stop 

Script Recording. 

2. Perform the manual operations that you want to record. For 

example, select a menu option, enter parameters in a dialog, 

or type a password. 

3. Select Script | Pause Script Recording if you do not want to 

record certain operations. The script recording process pauses 

and the menu option changes to Continue Script Recording. 

4. Select Script | Continue Script Recording to resume the 

recording. 

5. Select Script | Stop Script Recording or click  when you 

have performed all the operations to be stored in the script. 

You can also save the script that you just created, so that you 

can run it at any time to repeat the operations. 

 To activate a recorded script: 

Select Script | Activate Recorded Script (<Alt>+<F9>). The 

script currently recorded in memory is now activated. 

 To save a recorded script: 

1. Select Script | Save Recorded Script. The Save Recorded Script 

dialog appears. 

2. Enter a script name. 

3. Click OK. The script will be saved with the specified name. 

 To run a specific script: 

1. Select Script | Run Script. The Run Script dialog, which lists all 

the saved scripts, appears. 

2. Double-click the script that you want to run. The selected script 



 

        Ericom® PowerTerm® Pro           99 of 150         User’s Guide 

is executed. 

 To run individual script commands: 

1. Select Script | Script Command. The Script Command dialog 

appears. 

2. Type the name of the script command you want to run. 

Include parameters if necessary. 

3. Click OK. The specified script command is executed at once. 

 To run a script at startup: 

This option creates a Windows shortcut to PowerTerm Pro and a specific 

script file. It can be used to connect to different hosts using different 

scripts. 

The following procedure describes one way to create a shortcut. Consult 

your Windows documentation for a description of other available options. 

1. Locate the file ptpro.exe on your computer. 

2. Right-click and select Create Shortcut. The Shortcut to 

ptpro.exe appears in the current install folder. 

3. Right-click the created shortcut and select Properties. The 

Shortcut to ptpro.exe Properties dialog appears. 

4. In the Target field, add a space after the .exe file name and 

then type the name of the required script (.psl) file. You can 

also add parameters to the script file. These determine 

communication parameters, for example the name of the host 

to which you want to connect, or the Port number. 

In the Target field, add a space after the .psl script file and 

then type the required parameters. Parameters should be 

separated by a space. 

Example: 

\PTPRO\PTPRO32.EXE COMM.PSL 1 9600 xonxoff 

PowerTerm Pro recognizes Windows file naming conventions, 

including spaces in a file name. If you have a setup file with a 

space in the name, PowerTerm Pro ignores the space and looks 

directly for the .psl extension. 

5. Click OK. When you start PowerTerm Pro, the script file is 

automatically executed and you are connected to the host that 

you specified in your setup file. 

 To run a script file upon connecting to a host: 

1. Open the Connect dialog. 

2. Click the browse button next to Script File in Upon Connection 

Run. 

3. Select the desired file. 
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4. Click OK. The designated script will be executed upon 

connection. 

 To run a script file during a PowerTerm Pro session using Soft 

buttons: 

Click the Soft button that has the desired script assigned. The 

script is executed. For more information, see chapter Soft 

Buttons and Power Pad. 

 To run a script file during a PowerTerm Pro session using the 

Power Pad: 

Click the Power Pad button that has the desired script 

assigned. The script is executed. For more information, see 

chapter Soft Buttons and Power Pad. 
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10. POWERTERM PRO ENTERPRISE - 
VBA  

The PowerTerm Pro Enterprise allows you to use Visual Basic for 

Applications (VBA) to add programmability to your application. 

VBA is an attractive alternative to the PowerTerm Power Script Language 

(PSL), approaching acceptance as the industry standard. VBA is common 

to many programming applications, including Microsoft Office products. 

The programming knowledge acquired in any of these products will be 

immediately applicable to any other product that uses VBA. If you already 

have an application installed that uses VBA, PowerTerm Pro Enterprise 

uses that component. 

With VBA you can: 

 Create custom dialog boxes and forms. 

 Integrate with Internet and intranet solutions. 

 Create instances of OLE (ActiveX) objects within your code. 

 Create classes (reusable custom software objects). 

 Store and retrieve data from the Windows registry. 

 Detect and handle errors. 

 Incorporate ActiveX controls into the application interface. 

 Pass data between VBA-enabled applications with a minimum of 

programming and fuss. 

 Drive a second VBA-enabled application from within the initial 

VBA-enabled application. 

 Control the Office application. (In theory, 100% of the 

functionality of Office products is exposed as 

objects/properties/methods, which means that, with occasional 

exceptions, you can programmatically do anything from the 

application’s interface.) 

Automation is the key technology that makes individual Microsoft Office 

applications programmable. This technology allows a developer to use 

VBA code to create and control software objects exposed by any 

application, dynamic-link (DLL), or ActiveX control, which supports the 

appropriate programmatic interfaces. 

The key to controlling an OLE automation application is a firm 

understanding of the application’s object model. The object model is a 

hierarchy of objects that the application exposes. It acts to describe the 

application to you, the developer. Each application’s object model is 

different, and the amount of control you have over the application varies 

accordingly. The application also exposes the object’s methods and 

properties with which the user works. 
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This chapter will describe: 

 PowerTerm Pro Enterprise VBA editor  

 PowerTerm Pro Enterprise VBA Sample Scripts 

 A List of VBA Commands 

PowerTerm Pro Enterprise VBA Editor 

The PowerTerm Pro Enterprise VBA editor enables you to write VBA 

scripts, which can access and manipulate PowerTerm Pro Enterprise 

objects and attributes. 

VBA’s IntelliSense™ natural-language technology makes it easier for 

users to finish their tasks. Previously, a user had to guess the technical 

description of a task in order to get help for it. Statement Completion 

acts as a guide leading you through the object’s hierarchy as you are 

coding by displaying only those objects, methods, properties, and events 

that are available for the code you are currently writing, thus helping to 

speed up the development of VB applications. Debugging is accomplished 

with a minimum of effort assisting the programmer with the required 

syntax. Online help is also available. 

To start the VBA editor: 

1. Select Tools | Macro.  

2. Select Visual Basic Editor. The Microsoft Visual Basic screen 

appears. 

Reference 

By adding an object reference to your project, you expose the class’s 

type library to the VBA environment, allowing the details of its class 

hierarchy to be displayed as you enter your code. By default, PowerTerm 

Pro Enterprise is referenced by your project. You can confirm this by 

selecting References from the Tools menu. 

Objects, Properties and Methods 

The objects, properties and methods are the means in which you can 

interact with the PowerTerm Pro Enterprise. The Object Browser displays 

the classes, properties, methods, events, and constants available from 

the object libraries and procedures in your project. You can use it to find 

and use objects you create, as well as objects from other applications. 

To view PtPro objects, properties and methods: 

1. Select Tools | Macros. 

2. Select Visual Basic Editor. The Microsoft Visual Basic screen 

appears. 

3. Select View | Object Browser (or press F2). The Object Browser 
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dialog appears. 

4. Select the Pterm Pro library from the library list. 

5. Select the desired object from the Classes list. The members, 

methods and properties of the selected object are displayed. 

6. Click on any object to display the prototype of the method or 

property and its definition.  

Example 

This example will show how to create a dialog box that will facilitate a 

connection with a host: 

1. Open the PowerTerm Pro Enterprise VBA editor. 

2. Select View | Project Explorer. The Project Explorer dialog box 

appears. 

3. Select Project and right-click.  

4. Click Insert | Userform. A blank Userform is displayed. 

5. Select View | Toolbox. The Toolbox is displayed. 

6. Click the Label icon in the toolbox. Drag it onto Userform and 

drop it. 

7. Repeat previous step three times for the three labels you are 

creating. 

8. Select Label1 and right-click Properties. 

9. Change Caption to “Host”. 

10. Select Label2 and right-click Properties. 

11. Change Caption to “User”. 

12. Select Label3 and right-click Properties. 

13. Change Caption to “Password”. 

14. Click the Textbox icon in the toolbox. Drag it to the right of the 

Host label in the Userform and drop it. 

15. Repeat previous step for both the User and Password labels. 

 

The following code for the Auto login dialog is automatically generated:  

Private Sub cmdconnect_Click() 

On Error GoTo errorhandler 

If main.host = "" Then 

MsgBox "Please enter Host name", vbExclamation, "Host" 

main.host.SetFocus 

Exit Sub 

End If 
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Session.HostName = main.host  

Call Session.Modify 

 

Call Session.Open("") 

PtermPro.WaitForText user, 5, 0, 0 

PtermPro.Send user & "<enter>" 

 

Exit Sub 

errorhandler: 

MsgBox Err.Description, vbCritical, "Error" 

End Sub 

Creating a VBA Macro from an Existing PSL Script 

It is not necessary to create VBA macros from scratch if you already have 

PSL scripts. An example of a PSL script: 

# 

# Opens a TELNET connection (Via TCP/IP WINSOCK api). 

# 

# Parameters : $p1 - host name. 

# $p2 - telnet port number. 

# 

set comm-type telnet 

set host-name 126.0.0.200 

set telnet-port 23 

session open 

 

Following is an example that will show how to create a dialog box that 

would facilitate making a connection with the Host via PowerTerm Pro 

Enterprise: 

1. From within the Microsoft VBA editor, click on the Project 

Explorer icon on the toolbar (or alternately select View menu | 

Project Explorer). The Project Explorer dialog appears. 

2. Select Project from the right-hand pane and right-click.  

3. Click Insert | Userform. A blank Userform is displayed. 

4. Click on the Toolbox icon from the toolbar (or alternately select 

View menu | Toolbox) The Toolbox appears. 

5. Click on the Label icon from the toolbox. Drag it to Userform 
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and drop it. 

6. Repeat Step 5 three times. 

7. Select Label1 and right click to Properties. 

8. Change Caption to “Host”. 

9. Select Label2 and right click to Properties. 

10. Change Caption to “User”. 

11. Select Label3 and right click to Properties. 

12. Change Caption to “Password”. 

13. Click the Textbox icon from the toolbox. Drag it to the right of 

the Host label in the Userform and drop it. 

14. Repeat Step 13 for both the User and Password labels. 

 

The following code for the Auto login dialog is generated:  

Private Sub cmdconnect_Click() 

 

On Error GoTo errorhandler 

If main.host = "" Then 

      MsgBox "Please enter Host name", vbExclamation, "Host" 

      main.host.SetFocus 

      Exit Sub 

End If 

   

Session.HostName = main.host  

Call Session.Modify 

Call Session.Open("") 

PtermPro.WaitForText user, 5, 0, 0 

PtermPro.Send user & "<enter>" 

Exit Sub 

errorhandler: 

MsgBox Err.Description, vbCritical, "Error" 

End Sub 

PowerTerm Pro Enterprise VBA Sample 
Scripts 

PowerTerm Pro Enterprise provides several sample scripts designed for 

frequent tasks. The following table lists the sample scripts and their 
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parameters: 

 

Script Parameters Parameter Values 

APPC System name Specify the name of the system. 

 Device name Specify the name of the device. 

BAPI Host name Specify the name of the host. 

COMM Port number 1 – 4 

 Baud rate 300 – 115200 

 Protocol type none, xonxoff, hardware 

 Phone number  

CTERM Node name Specify the name of the CTERM 

node. 

LAT Service name Specify the name of the service. 

MSSNA LU name or LU pool name Specify the LU name or LU pool 

name. 

NWLAT User name (a NetWare 

user name without 

password) 

Specify the user name. 

 Service name Specify the name of the service. 

NWSAA Server name (a NetWare 

for SAA server name) 

Specify the name of the server. 

 User name (a NetWare 

user name without 

password) 

Specify the name of the user. 

 Service name (profile) Specify the name of the service. 

 LU category Public, pooled, dedicated 

 LU name of LU pool name Specify LU name or LU pool name. 

TELNET Host name Specify the name of the host. 

 Telnet port number Specify the telnet port number. 

TN3270 Host name Specify the name of the host. 

 Telnet port number Specify the telnet port number. 

 LU name Specify LU name. 

TN3270E Host name Specify the name of the host. 

 Telnet port number Specify the telnet port number. 

 LU name LU name. 

TN5250 Host name Specify the name of the host. 

 Telnet port number Specify the telnet port number. 



 

        Ericom® PowerTerm® Pro           107 of 150         User’s Guide 

NOTE All parameters must be typed in lowercase letters.  

PowerTerm Pro Enterprise VBA Commands 

The PowerTerm Pro Enterprise VBA commands can be divided into the 

following groups: 

Application Class Objects 

Application Class Properties 

Application Class Methods 

Session Class Properties 

Session Class Methods 

Setup Class Properties  

Enumerations 

 

The following is a short description of each: 

Application Class Objects 

Application Defines an object representing the entire PowerTerm Pro 

Enterprise application. 

 

Session Returns an object representing PowerTerm Pro Enterprise current 

session. 

 

Setup Returns an object representing PowerTerm Pro Enterprise current 

setup. 

 

Application Class Properties 

ExcelEmbedded  Microsoft Excel embedded in PowerTerm Pro Enterprise. 

 

Height The height (in pixels) of the PowerTerm Pro Enterprise window. 

 

InternBrowserEmbedded Internet browser embedded in PowerTerm 

Pro Enterprise. 

 

Left The location of the left margin of the PowerTerm Pro Enterprise 

window (in number of pixels from the left margin of the screen). 
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Parent Returns an object representing the entire PowerTerm Pro 

Enterprise application. 

 

Session Returns an object representing PowerTerm Pro Enterprise current 

session. 

 

Setup Returns an object representing PowerTerm Pro Enterprise current 

setup. 

 

Top The location of the top of the PowerTerm Pro Enterprise window 

(in number of pixels from the top margin of the screen). 

 

Width The width (in pixels) of the PowerTerm Pro Enterprise window. 

 

WordEmbedded Microsoft Word embedded in PowerTerm Pro 

Enterprise. 

 

Application Class Methods 

AutoUpdatePrinter Updates the printer setup from windows. 

ClearDtr Clears the Data Terminal Ready signal. 

ClearRts Clears the Ready To Send signal. 

ClearScreen Clears screen. 

Display Display a string on the current cursor position. 

ExecEmbedded Runs the specified program embedded in the 

PowerTerm Pro Enterprise container view. 

Exec Executes a command. 

Exit Exits PowerTerm Pro Enterprise. 

GetEnv Get an environment variable. 

GetCursorPosition Receives cursor position coordinates. 

GetPrinterName Returns the name of the printer you select. 

GetRectText Copies the text found in the specified rectangle. 

GetScreenText Copies complete lines from the starting position 

(startRow, startCol) up to and including the end 

position (endRow, endCol). 

GetWindowTitle Sets the text of the PowerTerm Pro Enterprise main 

window title. 

HideMenu Hides the PowerTerm Pro Enterprise menu. 
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HideWindow Hides the PowerTerm Pro Enterprise window. 

InputTrace Executes capture file. 

InputTraceEx Executes capture file chosen from the dialog. 

LockColumns Locks the number of columns preventing the user from 

making any modifications until he performs 

UnlockColumns. 

MapKeyToComman

d 

Configures a PC key to execute PSL commands. 

MapKeyToDefault Configures a PC key to its default. 

MapKeyToNull Configures a PC key to be inoperable. 

MapKeyToScript Configures a PC key to run a PSL script. 

MapKeyToVbaMacro Configures a PC key to execute VBA Macros. 

MapKeyToVtKey Configures a PC key to send a VT key. 

MaximizeWindow Maximizes the PowerTerm Pro Enterprise window. 

Message Displays a message. 

MinimizeWindow Minimizes the PowerTerm Pro Enterprise window. 

MoveWindow Changes the position and dimensions of the PowerTerm 

Pro Enterprise window. 

OpenPowerpadFile Opens a specified Power Pad file. 

OpenKeyboardFile Opens a specified Keyboard file. 

OpenPrinterFile Opens a specified printer file. 

OpenSetupFile Opens a specified setup file. 

OpenURL Opens a specified URL in PowerTerm Pro Enterprise 

internal browser. 

PrintFile Prints the specified file. 

PrintScreen Prints the data presently displayed on the emulation 

screen. 

ReceiveAsciiFile Receives file from the host using the ASCII protocol. 

ReceiveAsciiStop Receives ASCII stop. 

ReceiveBinaryFile Receives file from the host using the binary protocol. 

ReceiveBinaryStop Receives binary stop. 

ReceiveFile Receives file from the host using either the kermit, 

xmodem, ymodem, or zmodem protocol. 

ReceiveIndFile Receives file from the host for IBM emulation types. 

ReceiveIndFileEx Sets parameters for IBM emulation type file transfer 

and sends file. 

RestoreMenu Restores the PowerTerm Pro Enterprise menu. 
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RestoreWindow Restores the PowerTerm Pro Enterprise window. 

RingBell Rings the bell. 

Send Sends interpreted data to the host. 

SendAbortOutput Sends escape sequences to the host to stop sending 

output. 

SendAsciiFile Sends file to the host using the ASCII protocol. 

SendBinaryFile Sends file to the host using binary protocol. 

SendBreak Abort looping command. 

SetCursorPos Moves the cursor to the specified screen coordinates. 

SendFile Sends file to the host using either the kermit, xmodem, 

ymodem, or zmodem protocol. 

SetFunctionButton Programs the designated Function button. 

SendIndFile Sends file to the host for IBM emulation types. 

SendIndFileEx Sets parameters for IBM emulation type file transfer 

and receives file. 

SendRawText Sends non-interpreted text to host. 

SetColor Sets emulation screen color. 

SetCursorPos Moves the cursor to the specified screen coordinates. 

SetDtr Set the Data Terminal Ready signal. 

SetFunctionButton Programs the designated Function button to run PSL 

script command. 

SetFunctionButtonV

BAMacro 

Programs the designated Function button to run VBA 

macro. 

SetIndFileParamete

rs 

Sets parameters for IBM emulation type file transfer. 

SetPadButton Programs the designated Power Pad button. 

SetRts Set the Ready To Send signal. 

SetWindowFocus Activates the PowerTerm Pro Enterprise window. 

SetWindowPosition Sets the PowerTerm Pro Enterprise window position. 

SetWindowSize Sets the PowerTerm Pro Enterprise window size. 

SetWindowTitle Sets the text of the PowerTerm Pro Enterprise window 

title bar. 

ShowWindow Displays the PowerTerm Pro Enterprise window. 

StartAutoPrint Starts accumulating incoming data (while it is displayed 

on the screen). 

StatusMessage Displays status message. 

StopAutoPrint Prints all the data accumulated in the printing buffer of 
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the slave printer, or in the autoprint buffer. 

SwitchToView Switches to specific application view. 

ToggleAutoPrint Alternates between the start autoprint and stop 

autoprint states. 

UnlockColumns Unlocks columns allowing for the user to change the 

number of columns. 

Wait Wait for specific strings received from the host. 

WaitForRecord Only for 3270 emulations. 

The command instructs PowerTerm Pro Enterprise to 

wait for the next screen record from the mainframe. 

WaitForSystem Only for 5250 emulations. 

The command instructs PowerTerm to wait for the 

AS/400 to notify it when the AS/400 has finished 

processing a screen. 

WaitForText Wait for specific strings received from the host. 

WaitForTextOnScre

en 

Wait for specific strings received from the host, which 

are displayed on the screen. 

Session Class Properties 

AppcPassword Password. 

AppcUsername User Name. 

BaudRate Baud rate. 

CommPortNumber Comm port number. 

CommType Comm type. 

DeviceName Device name. 

DialNumber Dial Number. 

EnabledSsl Uses the Secure Sockets Layer protocol. 

FlowControl Flow Control. 

HostName Host name. 

LUCategory LU category. 

LUName LU name. 

MessageLibrary Message Library. 

MessageQueue An ordered list of messages awaiting transmission, 

from which they are taken up on a first-in, first-out 

(FIFO) basis. 

NodeName Node name. 

Parity Parity. 
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ServerName Server name. 

ServiceName Device name. 

SessionName Session name. 

StopBits Stop Bits. 

TelnetPort Telnet port. 

TerminalName Terminal name. 

UseAvailableLU Use Available LU. 

UseTN3270Eprotocol Uses the TN3270E protocol. 

Session Class Methods 

Close Closes Communication. 

Modify Modifies Communication. 

Open Opens Communication. 

SetComParameters Sets parameters for Comm communication. 

SetTelnetParameters Sets parameters for Telnet communication. 

Wait Begins a wait that is satisfied by the 

occurrence of the specified event. The  

Procedure containing the command is paused until the wait expires or is 

satisfied. 

Setup Class Properties  

EmulationType Emulation Type. 

PadColumns Pad Columns. 

PadRows Pad Rows. 

Parent Returns an object representing the 

PowerTerm Pro Enterprise setup. 

RTFCopy Sets RTFCopy (copies to clipboard in RTF 

format) setup flag. 

Enumerations 

AllocUnitsTracks An enumeration of allocation units tracks 

for file transfer. 

BaudRates An enumeration of baud rates for COM 

connection. 

CommProtocol An enumeration of protocol types (Flow 

Control) for COM connection. 
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CommType An enumeration of PowerTerm Pro 

Enterprise communication types. 

EmbeddedAppl An enumeration of applications that can be 

embedded. 

EmulationType An enumeration of PowerTerm Pro 

Enterprise Emulation Type. 

FileTransferAsciiFlag An enumeration of ASCII file transfer type 

flag. 

FileTransferType An enumeration of file transfer type. 

IndFileRecordFormat An enumeration of record format for IBM 

file transfer. 

IndFileTransferType An enumeration of file transfer type for IBM 

emulation types. 

LuCategory An enumeration of LU Categories for 

NWSAA connection. 

Parity An enumeration of parity values for COM 

connection. 

StopBits An enumeration of stop bits for COM 

connection. 

EnumViewType An enumeration of application views. 

 

To run VBA scripts from the Command line 

1. 1 Position your cursor on the command line, after the .exe 

file name. 

2. 2 Add a space and then type the name of the required script 

(.pcf) file.  

 

To add parameters to the VBA script file 

1. Position your cursor on the command line, after the PSL script 

name. 

2. Add a space and type the required parameters. Parameters 

should be separated by a space.  

Syntax 

ptpro.EXE pcf-filename vba-module-macro-name [ parameter-1 … ] 

Example 

“\PowerTerm Pro\ptpro.EXE“ Telnet.pcf MyMacro param1 param2 

PowerTerm Pro Enterprise VBA Sample Project 
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This project demonstrates how you can utilize VBA in conjunction with 

PowerTerm Pro/PowerTerm Pro Enterprise.  

 

To view the PowerTerm Pro Enterprise VBA Sample Project: 

1. Select Tools | Macro. 

2. Select Advanced.  

3. Run VBA Sample Project. The VBA Examples screen opens with 

the following examples: 

 

Home Allows the users to access the Internet, E-

mail and Snail mail. 

Scripting Examples Demonstrates several scripts, which 

interact with PowerTerm Pro Enterprise. 

Internet Launches the user’s Internet browser to a 

desired URL or Internet site.  

Auto Login Performs an effortless login to the host. 

Power Terminal Sends the PowerTerm Pro Enterprise 

emulation screen display to various 

destinations. 

System Info Demonstrates how VBA assists you in 

interacting with the API. It displays a list of 

all visible windows operating on the system 

and their relative positions. Double-clicking 

any one of the items on the list will open 

up that program. 

FTP Provides a user-friendly interface to 

connect to an FTP host. 

VBA Examples 

The PowerTerm Pro Enterprise provides you with different examples to 

study how VBA can be used for different purposes. 

System Info 

This screen demonstrates how VBA assists you in interacting with API 

(Application Programming Interface). The API is a set of routines that an 

application programmer uses to request and carry out lower-level 

services performed by a computer’s operating system. These 

maintenance chores are performed by the computer’s operating system, 

and an API provides the program with means of communicating with the 

system, telling it which system-level task to perform and when. 
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System Info displays a list of all visible windows operating on the system 

and their relative positions. Double-clicking any one of the items on the 

list will open up that program. 

 

To display information about one of the visible windows operating on 

the system: 

1. Click Show Windows. A list of all visible windows operating on 

the system is displayed. 

2. Select the desired application from the All Visible Windows list. 

The position of the selected application is displayed in the 

Window Position fields. 

Scripting Examples 

The Scripting Examples demonstrates several scripts that interact with 

PowerTerm Pro Enterprise. 

Scripting Examples Code  

The scripting examples code was provided with comments in order to 

facilitate the end-user who chooses to adapt these scripts by making 

small modifications. You can open the scripting examples file and make 

these changes according to your own specific requirements and use them 

afterwards. 

 

To modify the scripting examples file: 

1. Select Tools | Macro.  

2. Select Open VBA Project. The Open dialog box appears. 

3. Locate the PowerTerm Enterprise directory. 

4. Open the VBA folder. 

5. Select ptvbasmpl.pcf 

6. Click OK. The VBA Editor opens and displays the selected 

scripting examples file. 

7. Make the desired modifications to the script and save it as 

described below. 

 

To save a customized VBA Sample Project: 

1. Click Tools | Macro.  

2. Select Advanced.  
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3. Select Save VBA Project or Save VBA Project As. 
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11. APPLICATION PROGRAM INTERFACE 

(API) 

PowerTerm Pro InterConnect supports various APIs, such as 

 COM  

 DDE (currently not supported for Windows Vista and higher)  

 Hllapi, ehllap, and winhllapi. They all use the hllapi.dll file. This 

file can be renamed if necessary. 

For more information about how to use the different APIs’ commands 

please refer to “PowerTerm Pro Script Language Reference” for DDE and 

COM and to 

http://publib.boulder.ibm.com/infocenter/pcomhelp/v5r9/index.jsp?topic

=/com.ibm.pcomm.doc/books/html/emulator_programming07.htm for 

hllapi. 

http://publib.boulder.ibm.com/infocenter/pcomhelp/v5r9/index.jsp?topic=/com.ibm.pcomm.doc/books/html/emulator_programming07.htm
http://publib.boulder.ibm.com/infocenter/pcomhelp/v5r9/index.jsp?topic=/com.ibm.pcomm.doc/books/html/emulator_programming07.htm
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12. POWERTERM PRO FTP CLIENT 

The PowerTerm Pro FTP client is a client-server application, which uses 

the File Transfer Protocol (FTP). It provides an easy to use graphic user 

interface to define how to transfer files between your computer (client) 

and remote computers (servers), across a wide variety of platforms like 

Unix, Windows, and more. PowerTerm Pro FTP client provides direct 

access to any FTP server site. The server site only requires a login 

identity and password before it responds to requests. 

Features and Benefits 

PowerTerm Pro FTP client 

 Provides access to a wide variety of operating systems, including 

UNIX, Windows 98/ME/2000/NT/XP/2003/ Windows Vista/ 

Windows 7/ 2008/ 2008 R2/ 2012 / VAX/ VMS, IBM AS400, IBM 

Mainframe operating systems (such as MVS, VSE, etc.) and more. 

 Saves connection parameters in a configuration file. 

 Provides detailed on-screen connection information. 

 Provides a choice of Binary or ASCII data transfer modes. 

 Provides a variety of data conversion options. 

 Creates, removes and changes directories, as well as deletes and 

renames files. 

 Automates connection and transfer operations. 

 Provides support for a variety of firewall options. 

Concepts 

The following concepts are used in this guide: 

FTP Site The remote site to which you are connecting. In this 

guide this term is also known as a host or remote 

computer. 

Configuration 

Settings 

Contains your PowerTerm Pro FTP client preferences 

and selected data transfer mode. These parameters 

only remain active for a current transfer session, 

unless they are saved in a configuration file. 

Connection Profile Creates a connection profile for an FTP site with which 

you frequently establish communication. This profile 

contains login, system, and directory and firewall 

information. The connections profile, along with 

configuration information, is saved in a configuration 
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file. 

Connection List Displays, in the Connection dialog, the saved 

connection profiles. 

Configuration File Contains your connection profiles and configuration 
settings. Configuration files are saved with a .cfg 

extension. Default configuration file is ftp.cfg which is 

loaded at startup. 

Current Session Refers to the current connection between your PC and 

the remote computer. 

 

The PowerTerm Pro FTP client window consists 

of the following components: 
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PowerTerm Pro FTP Client Window 

Control Menu Box Provides standard Windows commands. 

Title Bar Displays the application name and the Configuration File 

currently in use. 

Menu Bar Contains drop-down menus, which enables you to 

access PowerTerm Pro FTP client functions. 

Toolbar Contains icons, which can be used as shortcuts to 

access frequently used menu commands. 

Display Area Displays information about a selected file, like file size, 

date and time for compilation etc. when you select more 

than one file, the combined size of files is shown. The 

Display Area also shows the current button, menu or 

toolbar option selected. When you connect to a remote 

PC, a message is displayed with the name of the host to 

which you are connecting. 

Application Status 

Icon 

Displays the activity status of PowerTerm Pro FTP client. 

The icon is active while the client is running. 

Menu Bar 

File Menu Provides options to create, open, and save a 

configuration file, as well as exit the client. 

Settings Menu Provides options to select preferences for file 

transfer and define the data translation mode. 

Services Menu Provides options to connect and display connection 

information in a log window. This menu also enables 

you to refresh the file list in both the local and 

remote directory. 

Help Menu Provides online help and product information. 

Toolbar 

New 
 

Creates a new configuration file. 

Equivalent to File | New 

Open 
 

Opens an existing configuration 

file. 
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Equivalent to File | Open 

Save 
 

Saves a configuration file. 

Equivalent to File | Save 

Options 
 

Opens the FTP - Preferences dialog 

which enables you to select 

preferences for file transfer.  

Equivalent to Settings | Options 

File Transfer Setup 
 

Opens the Data Conversion dialog 

which enables you to select options 

for data conversion. 

Equivalent to Settings | File Transfer 
Setup 

Connect 
 

Opens the Connect dialog which 

enables you to enter connection 

parameters for file transfer. 

Equivalent Services | Connect 

Log Windows 
 

Opens the Log – FTP window. 

Equivalent Services | Log 

Refresh 
 

Refreshes the display of directories 

and file names shown in the 

PowerTerm Pro FTP client window. 

Equivalent to Services | Refresh 

Exit 
 

Exits the PowerTerm Pro FTP client 

application. 

Equivalent to File | Exit 

A Quick Guide through PowerTerm Pro FTP 
Client 

The following workflow is a quick guide for using PowerTerm Pro FTP 

client. This quick guide is intended for users who are familiar with FTP 

applications. You can read a more detailed description on how to work 

with PowerTerm Pro FTP client in the following chapters. 
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Step 1: Launch PowerTerm Pro FTP client 

4. Select in the PowerTerm Pro window, Communication | Run FTP. 

The PowerTerm Pro FTP Client window opens. 

5. Click Connect. The Connect dialog appears. 

Step 2: Connect to an FTP site 

To define connection parameters for the current session, enter 

the required parameters in the Connect dialog. 

To save your connection profile for future sessions, type a 

profile name in the Description field and click Add. The 

connection profile is displayed in the Connection List. 

To select a connection profile, click on a profile in the 

Connection List. 

To connect to the specified FTP site, click Connect. 

Step 3: Transfer files 

Select Copy or Append in the lower part of the PowerTerm Pro FTP client 

window. 

Downloading files: 

1. Select the files to transfer in the Remote/Files field. 
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2. Click the left arrow button. 

Uploading files: 

1. Select the files to transfer in the Local/Files field. 

2. Click the right arrow button. 

Step 4: Exit 

1. Click Disconnect. A confirmation message is displayed. 

2. Click OK. 

3. Select File | Exit. 

Configuration Settings 

To set up your PowerTerm Pro FTP client working environment, you need 

to define PowerTerm Pro FTP client preferences and select the required 

file transfer mode. PowerTerm Pro FTP client also provides an option to 

select the data transfer conversion. You can save your own settings to a 

configuration file so that they can be used in later sessions. 

 The parameters that you define will only remain active for the current 

session, unless you save them. 

Defining PowerTerm Pro FTP Client Preferences 

PowerTerm Pro FTP client provides various options to customize your 

working environment. You can specify which actions will prompt you with 

a confirmation message (e.g. removing a file), and specify the 

information displayed when you connect to an FTP site. 
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Confirm Before Determines the actions which display a confirm message: 

Remove Directory, prompts you for confirmation before 

deleting directories from your computer or the remote FTP 

site. 

Append to File, prompts you for confirmation before 

appending (adding) a file to an existing file in your 

computer or the remote FTP site. 

Delete File, prompts you for confirmation before deleting a 

file from your computer or the remote FTP site. 

Replace File, prompts you for confirmation before 

overwriting a file in your computer or the remote FTP site. 

On Connection Determines the connection information displayed when 

you connect to an FTP site. 

Open Log Window, opens a temporary Log-FTP window, 

which displays the messages exchanged by your 

computer and the FTP site while connecting. This window 

enables you to monitor the status of the current FTP 

connection. 
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Write to Log File, saves connection details to a file, which 

you can then open and view at a later date. 

Clear Log File on Connect, clears the log file every time 

you connect to an FTP site. Only the current connection 

information is saved in the log file. 

Include Files List in Log, displays a list of remote file in the 

Log-FTP window. To access this option select Open Log 

Window. If you want to save this list to the log file, select 

Open Log File. 

General Determines general information displayed when you use 

the PowerTerm Pro FTP client. 

Keep Version No. of VMS File Names, retains the version 

number of the VMS file names. 

Show File Size, displays the size of files in the lower part 

of the PowerTerm Pro FTP client window. (To view the size 

of files, you may need to enlarge the window.) You can 

use standard windowing Shift and Ctrl keys to select 

multiple files and see the combined size of the selected 

files. 

Ignore Remote Files and Directories List, refrains from 

displaying the remote files and directories list. 

Save Settings on Exit, automatically saves the current 

configuration settings when you exit PowerTerm Pro FTP 

client, without prompting you to save theses settings. If 

you do not select this option, PowerTerm Pro FTP client 

will always prompt you to save the current configuration 

file when you exit the application. 

Preserve Case of File Names,  

Copies the original case of the file names. 

Password for Anonymous Login, provides PowerTerm Pro 

FTP client with a specified password for anonymous login. 
Type in your e-mail address in the Password field. 

 To define PowerTerm Pro FTP client preferences: 

1. Select Settings | Options. The FTP-Preferences dialog appears. 

2. Select the option that you require. 

3. Click OK. 

Selecting a File Transfer Mode 

PowerTerm Pro FTP client distinguishes between transferring Binary data 
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and transferring a text (ASCII) file. It is important to select the right 

transfer mode to obtain the correct information, when accessing files on 

host computers. By default, PowerTerm Pro FTP client transfers files in 

Binary mode. 

In Binary mode, data is copied bit by bit so that the original 

and the copy are identical. This mode is usually appropriate 

when transferring files between computers of the same type. 

Programs are usually transferred in Binary mode, for example, 

.doc, .bat, .exe, and .dll files. 

In Ascii mode, data is treated as a set of characters (seven bit 

plus one bit for parity checking). The characters transferred 

have the same meaning on the target computer as they have 

on the source computer. This mode is appropriate for 

transferring textual data between two different systems, for 

example UNIX and Windows. Text files are usually transferred 

in ASCII mode, for example, a file with the .txt extension. 

The following is a list of common file types and their recommended mode 

of transfer: 

Type of File Mode 

Text (.txt)  Ascii 

Spreadsheet Usually Binary 

Database Usually Binary 

Word Processor Ascii 

Program source code Ascii 

Electronic mail message Ascii 

UNIX shell archives (shar) Ascii 

Compressed files (zip, tar, lzh, arc, 

Binary arj) 

Binary 

Unencoded Ascii 

Executable Binary 

Executable script (bat, etc.) Ascii 

PostScript Usually Ascii 
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Hypertext (html) documents Ascii 

Pictures (tiff, jpeg, mpeg) Binary 

Rich Text Format (rtf) Ascii 

 When transferring files between UNIX FTP servers and Windows 

computers, select Binary mode if you are not sure about the kind of 

file you are transferring. 

 To select the data transfer mode: 

Click the Binary/Ascii button. 

File Transfer Setup Options 

You can setup the Data Conversion mode and Data Type for both your 

computer and the remote computer (host). 

 

Data Translation Defines the mode of transferring files: no 

translation, Ascii mode translation, and Ascii and 

binary translation. 

Host Data Type Defines the data type for the FTP site: 7-bit, 8-bit 

(DOS-Ascii), and 8-bit (Windows-Ansi). 

PC Data Type Defines the data type for your PC: DOS-Ascii and 

Windows-Ansi. 

 To select file transfer options: 

1. Select Settings | File Transfer Setup. The Data Conversion dialog 
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appears. 

2. Select the required file transfer setup parameters and click OK. 

Working with Configuration Files 

A Configuration file consists of the configuration settings you have 

defined and your connection profiles. You can save configuration settings 

to the default ftp.cfg configuration file, create a new configuration file, or 

save the configuration file under a different name. All configuration files 

are saved with a .cfg extension. You can use previously defined 

configuration settings by opening an existing configuration file, or by 

starting PowerTerm Pro FTP client with a customized configuration file. To 

do this, you should create a shortcut and add the name of the 

configuration file to it. For more information about creating a shortcut, 

see paragraph Automatic File Transfer 

 To create a new configuration file: 

Select File | New. A new configuration file called noname.cfg is created in 

which you can specify the parameters that you require. 

 To open an existing configuration file: 

1. Select File | Open. The Open Configuration File dialog appears. 

2. Select the configuration file that you require. 

3. Click Open. The configuration file opens with the settings that 

you previously defined. 

 To save a configuration file: 

1. Define configuration settings and connection profiles as 

required. 

2. Select File | Save. 

The file is saved without any confirmation prompt, if you have 

already saved the current configuration in a .cfg file. 

The Save File As dialog appears if the current configuration files 

is noname.cfg. 

 To save a file under a different name: 

1. Select File | Save As. The Save File As dialog appears. 

2. Specify a name in the File Name field. 

3. Click Save. The file is saved with a .cfg extension. 

Defining Connection Parameters 

You can set parameters for connecting to an FTP site. These parameters 
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include login, system and directory information. The last parameters that 

you specified in the Connect dialog are stored and displayed when you re-

open it (excluding the password). 

 The parameters that you define will only remain active for the current 

session, unless you save them. 

Connection Parameters 

 

Login Host Name, the remote computer that you want to access. 

Use the host computer's domain name or its IP address. 
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User Name, the account that you want to use to access the 

remote computer. Use anonymous if you do not have an 

account on the FTP server or enter your user name if you 

have a personal account on the remote computer. 

Password, enter the password that you have been assigned 

for personal FTP or enter your complete e-mail address for 

anonymous FTP. (The characters are displayed as 

asterisks.) 

Account, optional, may be required for personal FTP, in 

addition to your user name and password. 

System Port, a number that identifies an Internet application. 

Default port is 21. 

Type, the operating system used by the remote computer. 

Default type is Auto. 

Directory Optional parameters: 

Local, the local directory to or from which you want to 

transfer files. 

Remote, the remote directory to or from which you want to 

transfer files. 

Description A name for the connection profile. 

Connection 

List 

Displays a list of the existing connection profiles. 

PASV Mode Specifies that the program will work in PASV mode. 

Use Firewall Select this option to enable the Firewall button. 
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Firewall Parameters 

 

Host Name The computer that you want to act as a "security guard" prior 

to granting access to a remote computer. 

User Name The account of the computer that you want to perform the 

security check. 

Password Enter the password that you were assigned for the computer 

that performs the security check. 

Port A number that identifies an Internet application, which 

performs the security check. 

Default port is 21. 

Type The Firewall type. 

If you do not know which type of firewall you have, choose 

the default (the most popular) or contact your firewall 

manufacturer to verify the type. 

 To define connection parameters: 

1. Select Services | Connect or click . The Connect dialog 

appears. 
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4. Specify connection parameters. 

5.  To specify Firewall parameters: 

6. Open the Connect dialog and select Use Firewall to enable the 

Firewall button. 

7. Click Firewall. The Firewall dialog appears. 

8. Enter required parameters and select a firewall type. 

9. Click OK. 

Working with Connection Profiles 

If you frequently connect to a specific remote computer, you can create a 

Connection Profile for this computer to use again for other PowerTerm Pro 

FTP client sessions. This profile contains the connection parameters for 

the specific FTP site, for example the host name, user name and 

password. The connection profile you create is displayed in the 

Connection List, which is saved in the current Configuration File along with 

the configuration settings. PowerTerm Pro FTP client enables you to 

modify, delete, and reset (clear) the parameters of a Connection Profile. 

You can also use Reset to introduce new parameters and create a new 

Connection Profile. 

 To create a profile: 

1. Enter parameters in the Connect dialog. 

2. Type a profile name in the Description field. 

3. Click Add. The profile is created and displayed in the 

Connection List. 

 To modify a profile: 

1. Select the desired profile from the Connection List. 

2. Modify the parameters as required. 

3. Click Modify. The profile is modified. 

 To delete a profile: 

1. Select the desired profile from the Connection List. 

2. Click Delete. The profile is deleted. 

 To reset (clear) a profile: 

1. Select the desired profile from the Connection List. 

2. Click Reset. Parameters are cleared. 
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Connecting to an FTP Site 

Once you have defined your connection parameters or selected a 

connection profile, you are ready to connect to an FTP site. After the 

connection is established, the PowerTerm Pro FTP client window displays 

directories and files of the remote computer in the lower part of the 

window. A log window is also displayed if you have selected the Open Log 

Window option in the FTP - Preferences dialog. 

 To connect to an FTP site: 

1. Display the Connect dialog. 

2. Specify connection parameters or select a profile from the 

Connection List. 

3. Click Connect. 

Or, 

Double-click a profile in the Connection List. 

Using the FTP Log Window 

You can open a temporary log window to display messages exchanged 

(connection information) by the PowerTerm Pro FTP client and the remote 

server. You can either automatically display the log window every time 

that you connect to an FTP site, or you can open it for a specific session. 

 

Start/Stop Toggles between start/stop 

displaying connection information. 

Save Saves the connection information in 

a log file. 

Clear Clears the log window. 
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Close Closes the log window. 

 To automatically display connection information for all sessions: 

1. Select Settings | Options. The FTP-Preferences dialog appears. 

2. Select Open Log Window and click OK. The log window will 

automatically open and display connection information each 

time you connect to an FTP site. 

 To display connection information for a specific session: 

1. Select Services | Log. The Log-FTP window opens with no 

information. 

2. Click Connect in the PowerTerm Pro FTP client window and 

enter connection parameters. 

3. Click Connect. The log window now displays each step in the 

connection process. 

 To stop/start displaying connection information: 

Click Stop/Start to toggle between stopping and resuming the 

display. 

 To save the connection information to a log file: 

1. Click Save. The Save As dialog appears. 

2. Select the directory and specify the name of the file to which 

you want to save the connection information. 

3. Click Save. The file is saved with the .log extension. 

 To clear the log window: 

Click Clear. All connection information displayed is cleared. 

 To close the log window: 

Click Close. 

Working with Local and Remote Directories 
and Files 

The PowerTerm Pro FTP client enables you to manipulate directories and 

files in both your own computer and in the remote computer. It also 

provides options to select, create, and remove directories and files, as 

well as rename and view the contents of a file in the format that it was 
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created. 

 Some FTP sites may restrict access to certain functions, for example, 

removing a directory or deleting a file. 

 You can use standard windowing convention like Shift and Ctrl, to 

select multiple files. 

 To select a directory: 

There are several ways to select a directory and display its files. 

Select the required directory and click Change. 

Double-click the required directory. 

Type the directory name in the Directory field and press Enter 

on the keyboard. 

 To create a directory: 

1. Double-click the required drive. 

10. Type the new directory name in the Directory field and click 

Create. 

 To remove a directory: 

Select the directory you want to remove and click Remove. 

 To view a file: 

The file will be displayed in the format in which it was created, i.e. a file 

with a .doc extension will be opened in Word, and a file with a .txt 

extension will be opened in Notepad. 

Select the desired file and click View. 

Double-click the desired file. 

 To delete a file: 

Select the file you want to delete and click Delete. 

 To rename a file: 

1. Select the desired file and click Rename. The Rename dialog 

appears. 

2. Type the new file name and extension (if necessary), and click 

OK. The file is displayed in the file list with the new name. 
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 To refresh the directory display: 

Select Services | Refresh. All changes that you have made to directories 

and/or files are displayed. 

Transferring Files 

You can download and upload files between your computer and an FTP 

site. Files can be copied to a directory or appended to an existing file. 

Most menu options and toolbar icons are inactive during the transfer of 

files. However you can still perform informative operations such as view 

directory and file information, and access online help. You can minimize 

the PowerTerm Pro FTP client window while file transfer is in progress. 

 You can use standard windowing conventions like Shift and Ctrl to 

select multiple files. 

 To download file(s) from an FTP site: 

The name(s) of the file(s), which is to receive the downloaded file, must 

be specified. If the receiving file does not exist, the PowerTerm Pro FTP 

client will create it for you. The downloaded file is copied into your 

directory under this file name. If the receiving file already exists, the new 

file will overwrite it. 

Copying file(s) to your local computer: 

1. Select the target local directory. 

2. Select the file(s) to download from the FTP site. 

3. Select Copy. 

4. Click the left arrow. The FTP Transfer dialog graphically displays 

the progress of downloading the selected file(s). 

Appending file(s) from your local computer: 

1. Select the target local file(s). 

2. Select the file(s) to download from the FTP site. 

3. Select Append. 

4. Click the left arrow. The FTP Transfer dialog graphically displays 

the progress of downloading the selected file(s). 

 To upload file(s) to an FTP site: 

Copying file(s) to an FTP site: 

1. Select the target remote directory. 

2. Select the file(s) to upload from your computer. 
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3. Select Copy. 

4. Click the right arrow. The FTP Transfer dialog graphically 

displays the progress of uploading the selected file(s). 

Appending file(s) to an FTP site: 

1. Select the target remote file(s). 

2. Select the file(s) to upload from your computer. 

3. Select Append. 

4. Click the right arrow. The FTP Transfer dialog graphically 

displays the progress of uploading the selected file(s). 

Automatic File Transfer 

You can automate connection and transfer options by creating a shortcut 

which specifies the necessary parameters to perform these operations. 

Once you have created the shortcut, you activate it by double-clicking its 

icon. The following parameters can be specified: 

Connection parameters for connecting to an FTP site. They 

include the host site, user name, and password. 

File transfer parameters for connecting to an FTP site and 

transferring files to or from your computer. The transfer 

parameters include the location of the PowerTerm Pro FTP 

client and the host site, file transfer direction, and file path of 

the local or remote file that you want to receive or send. You 

can also use file transfer conventions to transfer all file, or all 

files of a single type, to and from a directory. 

 IMPORTANT The PowerTerm Pro FTP client uses a set sequence of 

parameters to transfer files. This sequence cannot be modified. 

Example of Connection parameters (P): 

 

Example of File Transfer parameters (P): 

 

 

Parameter 1 Host site name 
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Parameter 2 User name 

Parameter 3 Password 

Parameter 4 File transfer direction: 

Get for downloading 

Put for uploading 

Parameter 5 File transfer mode: 

Binary 

Ascii 

Parameter 6 Path and name of the local or remote file that you want to 

transfer, according to the file transfer direction specified in 

parameter 4. 

Parameter 7 Path and name of the local or remote file that received the 

transferred file, according to the file transfer direction 

specified in parameter 4. 

 IMPORTANT The PowerTerm Pro FTP client will display an error 

message telling you of any missing parameters. You must enter " " as 

the password parameter rather than leaving it empty. 

 To create a shortcut: 

The following procedure describes one way to create a shortcut. Consult 

your Windows documentation for descriptions of other methods. 

1. Locate the file ftpc32.exe on your computer. It resides in the 

PowerTerm Pro installation folder. 

2. Right-click and select Create Shortcut. The shortcut to 

ftpc32.exe appears in the current folder. 

3. Right-click the shortcut and select Properties. The Shortcut to 

ftpc32.exe Properties dialog appears. 

4. Enter after the Target file path, the required parameters. 

5. Click OK. The next time that you open PowerTerm Pro FTP 

client, it will open with the defined parameters. 

File Transfer Conventions 

You can use wildcards and combinations of them, in parameters 6 and 7 
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to transfer groups of files. The symbols used for wildcards are: 

* Any character combination 

? Any single character 

 To transfer all files with the same extension: 

Type * and the file extension to upload or download all files of this type in 

a directory. 

Example: 

All files with the .cpp extension will be copied to /usr/pub/Ericom 

C:\*.cpp /usr/pub/Ericom/ 

 To transfer all files of one type and save them with a different 

extension: 

Type * and the extension that you want to give to the transferred files. 

Example: 

All files with the .cpp extension will be copied to the folder 

/usr/pub/Ericom receiving the same name, but with a .txt extension 

C:\*.cpp /usr/pub/Ericom/*.txt 

 To append all files of one type to a specific file: 

Type the name of the file to which you want to append the transferred 

files. 

Example: 

All files with the .cpp extension will be appended to the file 

/usr/pub/Ericom/aaa.txt 

C:\*.cpp /usr/pub/Ericom/aaa.txt 

 To transfer a file to another unknown file: 

Type ? for the unknown letter in the file name. 

Example: 

The file aaa.log will be copied to the file /usr/pub/Ericom/babcc.txt 

C:\aaa.log /usr/pub/Ericom/b?b*.txt 

Disconnecting and Exiting 

Before you exit the PowerTerm Pro FTP client, you need to disconnect 

from the current FTP site. 



 

        Ericom® PowerTerm® Pro           140 of 150         User’s Guide 

Changes to the preferences are either saved automatically when you exit 

the client, if you selected Save Settings on Exit, or you are prompted to 

save them. 

 To disconnect from an FTP site: 

Click Disconnect. 

 To exit the PowerTerm Pro FTP client: 

Select File | Exit. 

Troubleshooting the PowerTerm Pro FTP 
Client 

If you have any difficulties with PowerTerm Pro FTP client, refer to the 

following checklist: 

Connection cannot be 

established 

Ensure that the remote system 

provides an FTP server, which is 

running. 

Ensure you have entered the 

system type correctly. Select 

Auto if you do not know the 

system type to which you are 

connecting. 

PowerTerm Pro FTP client 

reports a login failure 

Ensure that the User name and 

Password were entered correctly. 

Files cannot be transferred or 

received 

Ensure that the correct transfer 

type (Binary or Ascii) is selected. 

Transferring a file in the incorrect 

mode may corrupt that file. 

Select Binary, unless you transfer 

text files to or from a UNIX FTP 

server 

Ensure that you have the 

necessary permission for specific 

operations, like write access to a 

directory. 
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13. CREATING CAPTURE AND LOG 

FILES TO SEND TO ERICOM 

SUPPORT 

Ericom Software’s Technical Support team can assist whenever needed, 

providing that you send them the required information. This feature 

automates the process for the end-user. 

 

 

    To create the necessary captures and log files to send to 

support: 

1. Open PowerTerm Pro InterConnect. 

2. Connect to your host 

3. Perform the following: 

Press key combination Appears on the Status bar 

ctrl+shift+s "capture.log with send with keys" 

ctrl+shift+k "capture.log with send"  

ctrl+shift+t  "tcpip.log" 

Warning: One’s password is liable to be recorded in this manner. 

4. Connect to host and arrive at the trouble spot. 

5. Continue with the following: 

 

Press key combination Appears on the Status bar 

*ctrl+shift+s "capture file end" 

ctrl+shift+t "tcpip.log end" 

ctrl+shift+v View the log file before it's sent. 

*mandatory 

 

6. Click Send. The CAB file is sent to Ericom Software’s Technical 

Support. 
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14. LIST OF SUPPORTED CODE PAGES 

VT and other character mode emulations 

7 bit character sets: 

None 

British 

Bulgarian 

Dutch 

Finnish 

French 

French Canadian 

German 

Greek 

Italian 

Norwegian Danish 

Portuguese 

Slovenian 

Spanish 

Swedish 

Swiss 

Turkish 

 

8 bit character sets: 

DEC Multinational  

ISO Latin 1 (USA)  

ISO Latin 2 (East European)  

ISO Latin 4 (North European)  

ISO Latin 5 (Turkish)  

ISO Latin 6 (Nordic)  

ISO Latin 7 (Baltic)  

ISO Latin 9 (western with Euro sign instead of the international 

currency symbol)  

DEC Cyrillic  
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ISO Cyrillic  

DEC Greek  

ISO Greek  

HP Roman 8  

DGI    (Data General International) 

Code Page 437 (PC USA)  

Code Page 620 - Polish (Mazovia) 

Code Page 737 Greek IBM PC de facto Standard (Greek 437) 

Code Page 775 (Baltic)  

Code Page 808 Russia (866 with Euro) 

Code Page 848 (Cyrillic, Ukrainian with Euro) 

Code Page 850 (Multilingual)  

Code Page 851 (Greek)  

Code Page 852 (Poland, Hungary, Romania, Slovakia, Czech, Croatia, 

Slovenia)  

Code Page 855 (Bulgaria, Serbia-Montenegro, FYR Macedonia)  

Code Page 857 (Turkish)  

Code Page 858 (850 with the Euro character) 

Code Page 860 (Portuguese)  

Code Page 863 (Canadian French)  

Code Page 865 (Nordic)  

Code Page 866 (Cyrillic) 

Code Page 872 Bulgaria, Serbia-Montenegro, FYR Macedonia (855 With 

Euro) 

Windows 1250 (Windows Eastern/Central European) 

Windows 1251 (Windows Cyrillic) 

Windows 1252 (Windows Latin 1 (US, Western Europe) 

Windows 1253 (Windows Greek) 

Windows 1254 (Windows Turkish) 

Windows 1257 (Windows Baltic)  

 

IBM (EBCDIC) emulations 

5250:  

037 (USA/Canadian)  

273 (German)  
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277 (Danish, Norwegian)  

278 (Finnish, Swedish)  

280 (Italian)  

284 (Spanish, Latin American)  

285 (UK English)  

297 (French)  

423 (Greek)  

500 (Belgian (New), Swiss (French and German))  

836 (People's Republic of China)  

870 (Poland, Hungary, Romania, Slovakia, Czech, Croatia, Slovenia)  

871 (Icelandic)  

875 (Greek)  

880 (Cyrillic)  

924 USA, Canada (French), Netherlands, Portugal, France, Finland 

1025 (Russia, Bulgaria, Serbia-Montenegro, FYR Macedonia)  

1026 (Turkish)  

1047 USA, Canada (French), Netherlands, Portugal (Latin-1/Open 

System)  

1140 USA, Canada (French), Netherlands, Portugal, Brazil, Australia, 

New Zealand (same as 037 but with Euro sign instead of the 

international currency symbol)  

1141 Germany, Austria (same as 273 but with Euro sign instead of the 

international currency symbol)  

1142 Denmark, Norway (same as 277 but with Euro sign instead of the 

international currency symbol)  

1143 Finland, Sweden (same as 278 but with Euro sign instead of the 

international currency symbol)  

1144 Italy (same as 280 but with Euro sign instead of the international 

currency symbol)  

1145 Latin America (Spanish), Spain (same as 284 but with Euro sign 

instead of the international currency symbol)  

1146 United Kingdom (same as 285 but with Euro sign instead of the 

international currency symbol)  

1147 France (same as 297 but with Euro sign instead of the 

international currency symbol)  

1148 Belgium, Switzerland (French), Switzerland (German) (same as 

500 but with Euro sign instead of the international currency symbol)  

1149 Iceland (same as 871 but with Euro sign instead of the 

international currency symbol)   
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1153 Latin 2 Multilingual (870 with Euro) 

1154 Cyrillic, Multilingual (880 with Euro) 

1155 Turkey (1026 with Euro) 

1158 Cyrillic, Ukraine with Euro  

 

3270:  

Cyrillic (same as 880)  

Danish (same as 277)  

English-UK (same as 285)  

English-USA (same as 037)  

Finnish (same as 278)  

French  (same as 297)  

German (same as 273)  

Greek (same as 423)  

Icelandic (same as 871)  

Italian (same as 280)  

Spanish (same as 284)  

Swiss (same as 500)  

Turkish (same as 1026)  

Latin-1/Open System (same as 1047) 

274 (Belgian) 

870 (Poland, Hungary, Romania, Slovakia, Czech, Croatia, Slovenia)  

875 (Greek) 

924 USA, Canada (French), Netherlands, Portugal, France, Finland 

1025 (Russia, Bulgaria, Serbia-Montenegro, FYR Macedonia)  

1140 USA, Canada (French), Netherlands, Portugal, Brazil, Australia, 

New Zealand  

 (same as 037 but with Euro sign instead of the international currency 

symbol)  

1141 Germany, Austria (same as 273 but with Euro sign instead of the 

international currency symbol)  

1142 Denmark, Norway (same as 277 but with Euro sign instead of the 

international currency symbol)  

1143 Finland, Sweden (same as 278 but with Euro sign instead of the 

international currency symbol)  

1144 Italy (same as 280 but with Euro sign instead of the international 

currency symbol)  
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1145 Latin America (Spanish), Spain (same as 284 but with Euro sign 

instead of the international currency symbol)  

1146 United Kingdom (same as 285 but with Euro sign instead of the 

international currency symbol)  

1147 France (same as 297 but with Euro sign instead of the 

international currency symbol)  

1148 Belgium, Switzerland (French), Switzerland (German) (same as 

500 but with Euro sign instead of the international currency symbol)  

1149 Iceland (same as 871 but with Euro sign instead of the 

international currency symbol)   

1153 Latin 2 Multilingual (870 with Euro sign instead of the 

international currency symbol) 

1154 Cyrillic, Multilingual (880 with Euro sign instead of the 

international currency symbol) 

1155 Turkey (1026 with Euro sign instead of the international currency 

symbol) 

1158 Cyrillic, Ukraine with Euro sign instead of the international 

currency symbol 

1160 Thai 838 with FE = Euro (€) 
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15. MENU ITEMS FOR POWERTERM 

PRO 

ActivateRecordedScript 

AutomaticCopy 

Break 

ClearDTR 

ClearHistory 

ClearRTS 

ClearScreen 

Connect 

Contents 

Cut / Copy / Paste 

CopyToFile 

Dial 

Disconnect 

EditScript 

Exit 

FileTransferSetup 

FormFeed 

General 

HideButtons 

HideMenu 

HidePowerPad 

HideStatusBar 

HideToolBar 

HoldScreen 

InputTrace 

KeyboardMap 

LineFeed 

ModemSetup 
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NewTerminalSetup 

NewTerminalWindow 

OnLine 

OpenKeyboardFile 

OpenPowerPadFile 

OpenTerminalSetup 

PauseScriptRecording 

PowerPadSetup 

PrinterN (where N represents one of the supplementary printers from 2-6) 

PrintScreen 

PrintSetup 

ReceiveAsciiFile 

ReceiveFile 

ReceiveINDFILE 

ReceiveKermit 

ReceiveZmodem 

Reset 

ResetCommunication 

ReverseScreen 

RunFTP 

RunScript 

SaveKeyboardFile 

SavePowerPadFile 

SaveRecordedScript 

SaveTerminalSetup 

SaveTerminalSetupAs 

ScriptCommand 

SelectHistory 

SelectScreen 

SendAsciiFile 

SendFile 

SendINDFILE 

SendKermit 
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SendZmodem 

SetDTR 

SetRTS 

ShowButtons 

ShowMenu 

ShowPowerPad 

ShowStatusBar 

ShowToolBar 

StartAutoPrint 

StartScriptRecording 

StartTrace 

StopScriptRecording 

StopTrace 

SystemFonts 

TerminalSetup 

ToggleAutoPrint 

ToggleScriptRecording 

ToggleTrace 
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About Ericom 

Ericom® Software is a leading provider of Application Access and 

Virtualization Solutions. Since 1993, Ericom has been helping users to 

access business-critical applications running on a broad range of 

Microsoft® Windows® Terminal Server, Virtual Desktops, Blade PCs, 

legacy hosts, and other systems. Ericom provides concrete business value 

by helping organizations realize the benefits of their IT investments. With 

offices in the United States, United Kingdom, EMEA, India and China, 

Ericom also has an extensive network of distributors and partners 

throughout North America, Europe, Asia and the Far East. Our expanding 

customer base is more than 30 thousand strong, with over 7 million 

installations. 
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